Introduction to Virtual Infrastructure

Using VMware VirtualCenter and ESX Server
Please note that you can always find the most up-to-date technical documentation on our Web site at http://www.vmware.com/support/.

The VMware Web site also provides the latest product updates.
Preface

This preface describes the contents of this manual, lists related documentation, describes document conventions, and provides references for support. This preface contains the following topics:

- Intended Audience on page 4
- Related Documentation on page 5
- Conventions on page 6
- Technical Support Resources on page 7
Intended Audience

This guide is for users, VirtualCenter administrators, and virtual machine administrators.

Document History

This is the Introduction to Virtual Infrastructure document, Revision xxxxxxxx, Item No. xx-xxxx-xxxx-xxx.

<table>
<thead>
<tr>
<th>Release</th>
<th>Date</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Release x.x</td>
<td>Month Day, Year</td>
<td>PDF, HTML on Web</td>
</tr>
</tbody>
</table>
Related Documentation

ESX Server 3.0 and VirtualCenter 2.0 documentation consists of the following publications:

- Documentation Roadmap
- Introduction to Virtual Infrastructure
- Installation and Upgrade Guide
- Server Configuration Guide
- Virtual Machine Backup Guide
- Web Access Administrator's Guide
- SAN Configuration Guide
- Resource Management Guide
- Setup for Microsoft Cluster Service
- Online help
- Hardware compatibility guides
  - I/O Compatibility Guide
  - SAN Compatibility Guide
  - Systems Compatibility Guide
  - Backup Software Compatibility Guide
- Release Notes
Conventions

This document uses the following conventions.

<table>
<thead>
<tr>
<th>Style</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>blue (online only)</td>
<td>Cross references, links</td>
</tr>
<tr>
<td>Courier</td>
<td>Commands, filenames, directories, paths, user input</td>
</tr>
<tr>
<td>Semi-Bold</td>
<td>Interactive interface objects, keys, buttons</td>
</tr>
<tr>
<td>Bold</td>
<td>Items of highlighted interest, terms</td>
</tr>
<tr>
<td>Italic</td>
<td>Variables, parameters, emphasis in text</td>
</tr>
<tr>
<td>italic</td>
<td>Web addresses</td>
</tr>
</tbody>
</table>

Abbreviations

The illustrations in this document use the following abbreviations.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>VirtualCenter</td>
</tr>
<tr>
<td>VI Client</td>
<td>Virtual Infrastructure Client</td>
</tr>
<tr>
<td>VM# or vm</td>
<td>Virtual machines on a managed host</td>
</tr>
<tr>
<td>disk#</td>
<td>Storage disk for the managed host</td>
</tr>
<tr>
<td>SAN</td>
<td>Storage area network type datastore shared between managed hosts</td>
</tr>
</tbody>
</table>
Technical Support Resources

The following sections describe various technical support resources available to you.

- Self-Service Support
- Online and Telephone Support
- Support Offerings

**Self-Service Support**

Use the VMware technology network for self-help tools and technical information:

- Product Information — [www.vmware.com/support/resources](http://www.vmware.com/support/resources)
- Technology Information — [www.vmware.com/vcommunity/technology](http://www.vmware.com/vcommunity/technology)
- Documentation — [www.vmware.com/support/pubs](http://www.vmware.com/support/pubs)
- Knowledge Base — [www.vmware.com/support/kb](http://www.vmware.com/support/kb)
- Discussion Forums — [www.vmware.com/community](http://www.vmware.com/community)

For more information about the VMware Technology Network, go to [www.vmtn.net](http://www.vmtn.net).

**Online and Telephone Support**

Use online support to submit technical support requests, view your product and contract information, and register your products. Go to [www.vmware.com/support](http://www.vmware.com/support).

Customers with appropriate support contracts should use phone support for the fastest response on priority 1 issues. Go to [www.vmware.com/support/phone_support.html](http://www.vmware.com/support/phone_support.html).

**Support Offerings**

Find out how VMware’s support offerings can help you meet your business needs. Go to [www.vmware.com/support/services](http://www.vmware.com/support/services).
# Table of Contents

1. Preface ................................................................................................................................. 3
   Intended Audience .................................................................................................................. 4
   Document History .................................................................................................................. 4
   Related Documentation ......................................................................................................... 5
   Conventions ............................................................................................................................. 6
   Abbreviations .......................................................................................................................... 6
   Technical Support Resources ............................................................................................... 7
      Self-Service Support ............................................................................................................ 7
      Online and Telephone Support .......................................................................................... 7
      Support Offerings ............................................................................................................... 7

1. Introduction to Virtual Infrastructure ..................................................................................... 13
   What Is Virtual Infrastructure? ............................................................................................... 14
      Benefits of Virtual Infrastructure ....................................................................................... 14
   Features of VirtualCenter 2 and ESX Server 3 ..................................................................... 15
      Virtual Machines ................................................................................................................. 15
      Storage ................................................................................................................................. 16
      Security ............................................................................................................................... 16
      Resource Management ....................................................................................................... 17
   Virtual Infrastructure Architecture ......................................................................................... 18
      VirtualCenter Server .......................................................................................................... 19
      ESX Server Hosts ................................................................................................................ 19
      Host States .......................................................................................................................... 20
      Virtual Machines ................................................................................................................ 20
      User Interface ..................................................................................................................... 21
      License Server ................................................................................................................... 21
   ESX Server Architecture ......................................................................................................... 22
      VMkernel ............................................................................................................................. 22
      VMkernel Resource Manager ............................................................................................. 22
      VMkernel Hardware Interface Layer .................................................................................. 23
      Virtual Machine Monitor .................................................................................................... 23

2. Getting Started with the VI Client ......................................................................................... 25
   VI Client Introduction ............................................................................................................ 26
      VI Client .............................................................................................................................. 26
      VI Web Access ................................................................................................................... 26
6. Best Practices

Setup and General Issues .................................................. 102
Sizing for Optimal Resource Consumption .......................... 102
Virtual SMP Best Practices .............................................. 103
Storage Best Practices ...................................................... 104
Related Publications ......................................................... 105
Introduction to Virtual Infrastructure

This chapter provides an introduction to Virtual Infrastructure as implemented with the VMware VirtualCenter 2 and ESX Server 3 product combination. The chapter first briefly defines Virtual Infrastructure and lists benefits of using Virtual Infrastructure. Then it describes features and architecture of the VirtualCenter 2/ESX Server 3 system. Finally, it offers some easy steps and short procedures to get you started using the Virtual Infrastructure Client (VI Client).

- What Is Virtual Infrastructure? on page 14
- Benefits of Virtual Infrastructure on page 14
- Features of VirtualCenter 2 and ESX Server 3 on page 15
- Virtual Infrastructure Architecture on page 18
- ESX Server Architecture on page 22
What Is Virtual Infrastructure?

The VMware Virtual Infrastructure approach to IT management creates virtual services out of the physical IT infrastructure, enabling administrators to allocate these virtual resources quickly to the business units that need them most.

This document discusses Virtual Infrastructure as implemented by the combination of VMware VirtualCenter 2 and ESX Server 3. The two products together allow you to significantly simplify IT so your company can leverage its storage, network, and computing resources to control costs and respond faster to business and customer needs.

Benefits of Virtual Infrastructure

Virtual Infrastructure separates your information systems from hardware, providing benefits such as:

- **Dramatic Cost Savings** — Save money spent on hosting, development, and test machines. Consolidate servers. Decrease your datacenter’s operating costs: Fewer servers means smaller demand for electrical power, temperature control, and physical security.

- **Scalable IT Infrastructure** — React rapidly to growing business needs and to meet demand for new applications. Use enterprise-wide CPU resources more efficiently. CPU utilization can average 50–70 percent on VMware ESX Server hosts, compared to 6 to 8 percent on most other servers.

- **Optimized Server Management** — Use the VirtualCenter Server, a Windows service to manage and serve ESX Server hosts, to view a unified dashboard showing enterprise-wide server statistics. VirtualCenter Server allows you to use one console to manage resource use and workloads across multiple systems and reallocate virtual machines to different physical servers without downtime to give users appropriate access during real-time demand changes. VirtualCenter also reduces deployment time substantially. Customers report one day provisioning rather than the six to eight weeks that had been required previously.

- **Better Customer Service** — Respond more quickly to technology needs. Immediately implement solutions requested by business groups or customers, without a delay for hardware procurement.

- **Testing and Development** — Accelerate software development and testing operations with easily provisioned and managed server-based virtual machines. VMware Virtual Infrastructure allows you to restore a machine’s previous state...
with a single command, so that you don't waste time reinstalling an operating system or application suite.

- **Standardized Platforms** — Take advantage of a new software platform more rapidly than in the past. You can deploy new operating systems and business applications into production environments, adopting new technologies rapidly while decreasing effort and risk.

### Features of VirtualCenter 2 and ESX Server 3

This section looks at some of the features of VirtualCenter 2 and ESX Server 3 in the following sections:

- **Virtual Machines**
- **Storage**
- **Security**
- **Resource Management**

**Note:** For some of the features discussed below, you need additional licenses.

#### Virtual Machines

Virtual machines are at the heart of your Virtual Infrastructure. Here are some features of particular interest:

- **Multiple processors on one virtual machine (VSMP)** — ESX Server 3 allows you to have up to 4 virtual processors per virtual machine.

- **Virtual Machine Templates** — Templates allow you to designate specific virtual machines as the golden images from which you can deploy new virtual machines. You can periodically power on virtual machine templates to keep them updated with the most recent operating systems and application patches.

- **Remote CD/Floppy** — Using either the Virtual Infrastructure Client or Virtual Infrastructure Web Access, you can give a virtual machine access to a CD or floppy device from the client’s machine. This means, for example, that you could install a program in a virtual machine running on a remote ESX Server by putting a CD in a drive on a desktop or laptop machine.

- **Snapshots** — Snapshots are manageable using the VI Client and capture the entire virtual machine state (all disks, plus memory, processor, and other virtual machine states). Snapshots are configured on an entire virtual machine and are
no longer per disk. Per-disk behavior can be achieved by using an independent 
disk configuration option for each virtual machine.

- **Performance Charts** — In the VI Client, you can create customized 
  performance charts and view detailed data. You can actually create performance 
  charts at each level of the inventory hierarchy and associate the appropriate 
  performance metrics associated with them. The information can then be 
  selected/deselected for viewing in real-time or across a specified time-interval. 
  Charts to display information at a 20 second sampling rate.

**Storage**

ESX Server 3 supports different storage devices and using different protocols. Most of 
this information is discussed in the *Server Configuration Guide*.

- **NAS and iSCSI Support** — NAS and iSCSI support lower-cost, more easily 
  managed shared storage. Guest virtual machines see the same virtual hardware 
  under all types of storage and are, therefore, reusable across storage 
  environments.

- **Raw Device Mappings (RDMs)** — You can use of raw device mappings when 
  booting from SAN; possible to cluster applications (for example, Microsoft 
  Cluster Server, or MSCS) in combination with using RDMs.

- **Support for Fibre Channel SANs** — ESX Server supports a large number of 
  Fibre Channel SANs from different vendors. You can connect to the SAN using a 
  Qlogic and Emulex HBA. ESX Server supports automatic failover if multipathing 
  has been set up. You can boot from SAN if that makes sense in your 
  environment. See the *SAN Configuration Guide* for more information.

- **Virtual Machine File System** — Your virtual machine is associated with a virtual 
  machine file system (VMFS-3). The files can be stored locally or remotely. ESX 
  Server creates a directory for each virtual machine and all its component files.

**Security**

- **ESX Server Security** — ESX Server 3 enables you to leverage built-in security 
  features to ensure a protected environment for your virtual machine 
  configuration. Features include restricted access to the VMkernel, virtual 
  machine isolation, tightened security for the service console, the ability to 
  protect virtual machines and the service console through virtual switch 
  configuration and VLANs, CHAP authentication for iSCSI, and user permission 
  model enforcement.
• **Virtual Machine Security** — ESX Server now offers NX/XD CPU security features. With the appropriate server hardware, the more recent guest operating systems will be able to leverage AMD’s No eXecute (NX) or Intel’s eXecute Disable (XD) technologies. Both variants (available in most of the recent CPUs from Intel and AMD) improve security by marking memory pages as data only to prevent malicious software exploits and buffer overflow attacks.

• **Permissions and Authentication** — VirtualCenter 2 and ESX Server introduce support for fine-grained permissions and user-defined roles. There is an extensive set of capabilities that can be added or subtracted from pre-defined roles and/or custom-defined roles. Users can be assigned to specific roles in order to restrict access to the inventory and to capabilities on that inventory. In addition, VirtualCenter maintains an audit trail of all significant configuration changes so that you can easily review changes and determine who made the changes.

**Resource Management**

All virtual machines share the resources of their host. In addition, multiple hosts can be combined into clusters. This allows you to provide fine-grained resource management as needed. See the *Resource Management Guide* for more information.

• **Resource Pools** — Resource pools allow you to subdivide the resources of a stand-alone host or a cluster. A resource pool is configured with a set of CPU and memory resources that are shared by the virtual machines that run in the resource pool. A typical use of resource pools is to delegate control over a precisely specified set of resources to a group or individual without giving access to the underlying physical environment.

• **VMotion** — Migration with VMotion allows you to migrate virtual machines to different hosts manually. You can migrate a running virtual machine to a different physical server connected to the same SAN without service interruption. Administration tasks include:
  • Performing zero-downtime maintenance by moving virtual machines around so the underlying hardware and storage can be serviced without disrupting user sessions.
  • Continuously balancing workloads across the datacenter to most effectively utilize resources in response to changing business demands.

• **Clustering** — You can create clusters to manage a collection of hosts, to a certain extent, as a single entity. In particular, the resources from all the hosts in a cluster are aggregated into a single pool. Thus, from the resource management
perspective, a cluster looks like a standalone host, but it would typically have a lot more resources available.

Some of the key new technologies that make clusters powerful are: DRS, resource pools, and distributed availability services. These are described below.

- **VMware DRS (DRS)** — DRS helps improves resource allocation across all hosts and resource pools. DRS collects resource usage information for all hosts and virtual machines in the cluster and gives recommendations (or migrates virtual machines) in one of two situations:
  - Initial placement — When you first power on a virtual machine in the cluster, DRS either places the virtual machine or makes a recommendation.
  - Load balancing — DRS tries to improve resource utilization across the cluster by either performing automatic migrations of virtual machines (VMotion), or by providing recommendation for virtual machine migrations.

- **VMware HA (HA)** — HA Allows administrators to organize virtual machines into failover groups. When a host fails, all its virtual machines are immediately started on different hosts. HA requires SAN storage. The virtual machine loses its memory state but its disk state is exactly as it was when the host failed (crash-consistent failover).

Refer to the Resource Management Guide for comprehensive information on using Virtual Infrastructure Client clusters.

**Virtual Infrastructure Architecture**

The new Virtual Infrastructure architecture consists of a VirtualCenter Server, one or more hosts, and the virtual machines running on the hosts. Client interfaces allow administrators to monitor and manage Virtual Infrastructure. An optional License Server stores and allocates licenses.

This section gives an overview of Virtual Infrastructure architecture; the next section, ESX Server Architecture on page 22, gives a more in-depth view of ESX Server.
The illustration below gives an overview of the components, which are discussed in more detail below.

**VirtualCenter Server**

The VirtualCenter Server acts as a central administrator for VMware servers connected on a network. The server directs actions upon the virtual machines and VMware ESX Server hosts. The VirtualCenter Server is a single Windows service that runs continuously in the background, performing monitoring and managing activities. VirtualCenter Server runs scheduled activities even when no VI Clients are connected. At this time, VirtualCenter Server supports only ESX Server.

**ESX Server Hosts**

Virtual machines run on individual ESX Server hosts. The ESX Server host includes a virtualization layer that manages resources and provides bootstrapping, management, and other services for your virtual machines. The server runs continuously in the background, performing its monitoring and management activities even when no clients are connected.

The illustration above shows only one ESX Server host; however, a large number of hosts can be managed by a single VirtualCenter Server.
A VirtualCenter managed host is an ESX Server host that is registered with VirtualCenter. The task of managing a host is accomplished through the Virtual Infrastructure Client (VI Client). This VI Client can be connected either directly to an ESX Server host or indirectly to ESX Server hosts through a connection to a VirtualCenter Server. ESX Servers not in clusters are referred to as stand-alone hosts. Managed hosts are hierarchically placed in datacenters, folders, or clusters under the root node folder.

**Host States**

Actions taken on a managed host require that the managed host be in a specific state. Whenever an operation is performed on a managed host, the host state changes. While the state is in transition, the state field displays a term that describes the transition.

Disconnecting a managed host is different from removing the managed host from the VirtualCenter Server. Disconnecting a managed host does not remove it from the VirtualCenter Server; it only temporarily suspends all VirtualCenter Server monitoring activities. The managed host and its associated virtual machines remain in the VirtualCenter Server inventory. Removing a managed host removes the managed host and all its associated virtual machines from the VirtualCenter Server inventory.

**Virtual Machines**

The core of Virtual Infrastructure is the virtual machine. In many ways, a virtual machine is set up just like a physical machine and includes:

- Operating system, software programs, and documents
- Configuration information, such as email server, default printers, and desktop pattern

However, a virtual machine is managed by Virtual Infrastructure. From the Virtual Infrastructure standpoint, the virtual machine includes:

- User access privileges and other security definitions
- Entitlement for CPU processing power, network bandwidth, disk allotment, and RAM
- The state of the machine. You can suspend and resume a virtual machine just as you would a laptop.

You create and manage virtual machines using the VI Client. The illustration above shows four virtual machines, each with its own operating system called a guest operating system.
User Interface
Administrators can view and manage Virtual Infrastructure components in several ways:

- A Virtual Infrastructure Client (VI Client) can connect directly to the ESX Server host. This is especially appropriate if there’s only one host in your environment.
- A VI Client can also connect to a VirtualCenter Server and interact with all ESX Server hosts managed by that VirtualCenter Server.
- VI Web Access allows you to perform many of the management tasks you perform through the VI Client but through a browser-based interface.

Note: With ESX Server 3 and VirtualCenter 2, you can perform almost all operations using the VI Client. For scripted interactions, you can use the Virtual Infrastructure SDK.

In the illustration above, two VI Clients and one VI Web Access Client access the VirtualCenter Server. They may be monitoring or creating virtual machines, adding or removing datastores, establishing network connections, or even adding more hosts to the VirtualCenter Server. Another VI Client is connected directly to the ESX Server host. This client has similar functionality but cannot do some things specific to VirtualCenter, such as creating clusters and adding hosts, or viewing performance or task information for multiple hosts at the same time.

As a rule, we recommend that you use the VirtualCenter Server to manage multiple hosts. Consider using a VI Client direct connection to ESX Server primarily in a single-host environment.

License Server
VMware offers two models for licensing software.

- **Hosted Licensing** — Maintains a separate license key file on each host and each server.
- **Served Licensing** — Maintains one license key file on a License Server. The VMware License Server is based on FlexNet® licensing technology.

If you are using a License Server, a Windows service authorizes operations based on purchased entitlement stored in a license pool. If a license is no longer in use — for example, because you disabled a feature — the license is automatically returned to the license pool. Using served licensing therefore guarantees optimal use of your licenses and is recommended.
ESX Server Architecture

Virtual Infrastructure components work together to run virtual machines and give them access to resources. This section briefly considers ESX Server architecture. The following illustration shows the main components of an ESX Server host.

**VMkernel**

The VMkernel is a high-performance operating system developed by VMware and runs directly on the ESX Server host. The VMkernel occupies the virtualization layer and manages most of the physical resources on the hardware, including:

- Memory
- Physical processors
- Storage and networking controllers

The VMkernel includes schedulers for CPU, memory, and disk access and has full-fledged storage and network stacks.

**VMkernel Resource Manager**

The resource manager partitions the physical resources of the underlying server. It uses a proportional share mechanism to allocate CPU, memory, and disk resources to virtual machines that are powered on.
Users can specify CPU reservations, limits, and shares for each virtual machine. The resource manager takes this information into account when it allocates CPU and memory to each virtual machine.

**VMkernel Hardware Interface Layer**

The hardware interface hides hardware differences from ESX Server and virtual machine users. It enables hardware-specific service delivery and includes:

- Device drivers
- Virtual Machine File System (VMFS) — A distributed file system optimized for large files like virtual machine disks and swap files.

VMFS-3 read-only locking code allows a maximum of eight hosts to open the same file in read-only mode. There can be any number of virtual machines on each host, but there can be at most eight hosts. Any additional host that tries to open the host will get a busy message.

**Note:** Device drivers and VMFS are discussed in the *Server Configuration Guide*.

**Virtual Machine Monitor**

The virtual machine monitor (VMM) is responsible for virtualizing the CPUs. When a virtual machine starts running, control transfers to the VMM, which begins executing instructions from the virtual machine. In part, the transfer of control to the VMM involves setting the system state so that the VMM runs directly on the hardware.

The Virtual Infrastructure architecture allows administrators to allocate hardware resources to multiple workloads in fully isolated environments called virtual machines.
Getting Started with the VI Client

This chapter gives an overview of the VI Client.

- VI Client Introduction on page 26
- VI Client Window on page 26
- Exploring Hosts and Resources on page 31
- VirtualCenter Administration on page 34
VI Client Introduction

You can monitor and manage your Virtual Infrastructure in several ways.

VI Client
The VI Client is the primary interface for creating, managing, and monitoring virtual machines, their resources, and their hosts.

VI Client is installed on a Windows machine separately from your ESX Server host or your VirtualCenter Server installation. While all VirtualCenter activities are performed by the VirtualCenter Server, you use the VI Client to monitor, manage, and control the server. A single VirtualCenter Server can support multiple, simultaneously connected clients.

VI Web Access
VI Web Access is the Web interface through which you can manage your virtual machines directly. VI Web Access is installed automatically when you install ESX Server. Functionality of VI Web Access is a subset of VI Client.

Service Console
The service console was used as the primary interface to ESX Server hosts. Starting with ESX Server 3, many of the commands are deprecated and service console is typically used only in conjunction with a VMware technical support representative. The VMware Virtual Infrastructure SDK is used for scripted manipulation of your Virtual Infrastructure instead.

VI Client Window

When the VI Client is connected to a VirtualCenter Server, the VI Client displays the options available to the Virtual Infrastructure environment based on the licensing you have configured. When the VI Client is connected to an ESX Server, only the options appropriate to single host management appear. Each server supports multiple VI Client sessions.

All the VI Client components—the hosts, the virtual machines, and the organizational groupings of datacenters: folders, resource pools, and clusters—are contained within the Virtual Infrastructure environment.
CHAPTER 2 Getting Started with the VI Client

Figure 2-1 Virtual Infrastructure Organizational Components
The default VI Client layout is a single window with a menu bar, a navigation bar, a toolbar, a status bar, a panel section, and popup menus.

To start a VI Client session

1. To launch the VI Client, double-click a desktop shortcut or choose the application through your start menu: Start > Programs > VMware > VMware Virtual Infrastructure Client 2.0.
2. Log on as either <local host name>\<user> or <user>, where <user> is a member of the local Administrators group.
3. Enter or choose the server name, your user name, and your password for that server.
4. Click Log In to continue.

The default localhost location is the local Windows server or machine where you started the VI Client. If you logged onto the VirtualCenter Server before, use the Server list drop-down menu to choose from the list of servers or type the name of the server on your network. An IP address or a name is acceptable.

Note: Only previously added servers appear in the Server drop-down menu.
The first time you log onto the VirtualCenter Server, an empty Inventory screen appears. Add a datacenter and host to begin monitoring and managing your virtual machines through the Virtual Infrastructure Client.

To stop a VI Client session:

1. Close the VI Client window.

The VI Client shuts down. The VI Client is logged out from the server. The server continues to run all its normal activities in the background. Any scheduled tasks are saved and performed by the VirtualCenter Server.

Note: Closing a VI Client does not stop the server.

Virtual Machine Console

The console of a virtual machine is available through a connected server. You can view the virtual machine console through the VI Client.

To view the virtual machine embedded console

1. Click the Inventory Navigation list selector.
2. Select Hosts & Clusters or VMs & Templates view.
3. Click a powered-on virtual machine in the Inventory panel.
4. Click the Console tab in the Information panel.

The embedded console appears.

To display the virtual machine console independent of the VI Client

1. Click the Launch VM Console icon in the navigation bar.

A copy of the Console window separates from the VI Client. Additional menu options are available from the pop-out Console window.

The pop-out virtual machine Console has the following menu items. The embedded Console has similar menu items but does not include all the external Console menu items.

Inventory Objects

Inventory objects help you organize your data centers by department, group, company function, location, and so on. Figure 1-3 shows the objects in a Virtual Infrastructure environment. The objects are in hierarchical order. Templates, networks,
and datacenters appear in their own inventory panel. All other objects appear in the Hosts and Clusters inventory panel.

When the VI Client is connected to an ESX Server, the root is the host itself. Contained objects include the host root resource pool, child resource pools, and virtual machines. Clusters, folders, datacenters, networks, and datastores do not apply when the VI Client is connected to an ESX Server only.
A datacenter is a structure for the VirtualCenter Server only. It can contain folders, clusters, and hosts on the Inventory Hosts and Clusters view. In the Networks, VMs & Templates, or Datastores view, the datacenters contain the virtual machines, templates, networks, and datastores associated with the managed hosts.

Inventory objects are restricted to their own datacenters. Networks and datastores are only unique within a datacenter. Use datacenters sparingly. VMotion does not work across datacenters. To use an object in another datacenter, for example, a template, register the template in multiple datacenters and then clone it.

Exploring Hosts and Resources

In this section, assume that you’ve installed the VI Client, added two ESX Server hosts to your VirtualCenter Server, and added some virtual machines. Now you are ready to explore hosts and resources.

To explore hosts and resources:

1. Double-click the VI Client to launch it, then log in.
   
   You must have permissions to log into the VI Client. An administrator user can use the VI Client to give other users access.

2. In the VI Client, notice the main elements.
Inventory Panel
The inventory panel on the left changes display depending on the choices you make in the Inventory navigation bar pop-up.
In the current display, you see datacenters, hosts, virtual machines, and one cluster.

- Datacenters can be used to group hosts and virtual machines.
- Hosts run the virtual machines.
- Clusters allow you to manage resources for multiple hosts jointly and turn on DRS, HA, or both.

Information Panel

The information panel on the right includes a number of tabs, discussed in detail in the VI Client Online Help. Available tabs change depending on the item selected in the inventory panel. For example, a Migration tab is displayed if you select a cluster.

3. For additional information about the host, you can explore the tabs. For example, click the Configuration tab to see more detailed information about the main components of the host.

4. On the configuration tab panel, select an item to display information about it.
In the screen below, **Storage** has been selected. The display shows available datastores and details about the datastores. You can use this page to

- Add datastores
- Remove a datastore
- View more details by clicking the **Properties** tab

---

**VirtualCenter Administration**

The following procedures must be performed by a user with VirtualCenter administrator permissions.

**Active Sessions**

When your VI Client is connected to a VirtualCenter Server, you can view the list of users logged onto the server. This is not available when your VI Client is connected to an ESX Server host.

**To view the users that are logged on to a VirtualCenter Server**

1. From the VI Client connected to a VirtualCenter Server, click the **Admin** button in the navigation bar.
2. Click the Sessions tab.

To terminate an active session
1. From the VI Client connected to a VirtualCenter Server, click the Admin button in the navigation bar.
2. Click the Sessions tab.
3. Right-click and select Terminate from the menu.
4. Confirm the terminated session.
5. Click OK.

To send a message to all users logged on in an active session
1. From the VI Client connected to a VirtualCenter Server, click the Admin button in the navigation bar.
2. Click the Sessions tab.
3. Type directly into the Message of the day: field.
4. Click the Change button.
   The text is sent as a notice message to all active session users.

Starting and Stopping Virtual Infrastructure Components
When you install your ESX Server, it automatically starts itself through the installation reboot process. If your ESX Server is shut down, you must manually start it.
To start your ESX Server

1. On the physical machine where the ESX Server is installed, press the power button until the power up sequence begins.

   The ESX Server boots, discovers its virtual machines, and proceeds with its normal ESX Server functions.

You have the option to power down (shut down) or restart (reboot) any ESX Server host managed by VirtualCenter. Powering down a managed host disconnects it from the VirtualCenter Server, but it does not remove it from the inventory.

To reboot your ESX Server

1. Start a Virtual Infrastructure Client.
2. Display the inventory panel and the ESX Server.
3. If you are connected to a VirtualCenter Server, display the inventory: Hosts & Clusters panel and choose the appropriate root folder (labeled Hosts & Clusters) or subfolder.
4. Select the appropriate ESX Server in the inventory panel.
5. From the Inventory > Host main or right-click pop-up menu, choose Reboot.

   The ESX Server shuts down and reboots.

To shut down your ESX Server

1. Start a Virtual Infrastructure Client.
2. Display the inventory panel and the ESX Server.
3. If you are connected to a VirtualCenter Server, display the inventory: Hosts & Clusters panel and choose the appropriate root folder (labeled Hosts & Clusters) or subfolder.
4. Select the appropriate ESX Server in the inventory panel.
5. From the Inventory > Host main or right-click pop-up menu, choose Shut Down.

   The ESX Server shuts down. You must manually power the system back on.

To manually stop your ESX Server

1. Log on to your ESX Server service console.
2. Execute the shutdown command. For example:
   
   `#shutdown -h now`

   ESX Server gracefully shuts down. When it is finished, a message appears, indicating that it is safe to power off your system.
3. Press the power button until the machine powers down.

To verify that the VirtualCenter Server is running, check your Windows Services
1. Depending on your Windows version, go to the Services display.
   For example, in Windows 2000, select Control Panel > Administrative Tools > Services > VMware VirtualCenter Server.
   The Status column indicates whether or not the service is started.
2. Right-click the VMware VirtualCenter Server and choose Properties.
3. In the VMware VirtualCenter Services Properties dialog box, click the General tab and view the service status.

To start the VirtualCenter Server through your Windows Services
1. Depending on your Windows version, go to the Control Panel > Administrative Tools > Services > VMware VirtualCenter Server.
2. Right-click VMware VirtualCenter Server, choose Start, and wait for startup to complete.
3. If the VMware Web Service is installed, right-click VMware Virtual Infrastructure Client Web Service and choose Start.
   Wait for it to complete.
   The Web service depends on VirtualCenter and is stopped whenever the VirtualCenter Server stops.
4. Close the dialog box.

To stop the VirtualCenter Server
1. Display the Windows Services dialog box.
   For example, in Windows 2000, choose Start > Control Panel > Administrative Tools > Services > VMware VirtualCenter Server.
2. Right-click the VMware VirtualCenter Server, choose Stop, and wait for it to stop.
   If dependent VMware services are installed, the Stop Other Services dialog appears.
3. To stop a service, click Yes.
   The Web service must be stopped whenever the VirtualCenter Server stops.
4. Click the X at the top of the dialog box to close it.
You should not have to stop the VirtualCenter Server. It is best for the VirtualCenter Server to run continuously. Continuous operation ensures that all monitoring and task activities are performed as expected.

**Establishing Connections Using the VI Client**

By default, the VirtualCenter Server or ESX Server receives data transmissions from the VI Client on port 902. If a firewall is preventing the VI Client from connecting to the server, you can reconfigure your firewall to allow the VI Client to communicate with port 902 on the VirtualCenter Server. Refer to the instructions for your firewall.

Alternately, you can use some port other than 902 and, if necessary, configure your firewall to open this other port. You need to configure the server to use the desired port.

**Note:** Refer to the Server Configuration Guide for complete information on security and communication with an ESX Server directly.
This chapter describes users, groups, roles, and permissions.
This chapter contains the following sections:

- Users, Groups, Permissions, and Roles on page 40
- Planning Access Permission on page 58
Users, Groups, Permissions, and Roles

VirtualCenter and ESX Server hosts determine the level of access for the user based on the permissions assigned to the user. The combination of user name, password, and permissions is the mechanism by which VirtualCenter and ESX Server hosts authenticate a user for access and authorize the user to perform activities. The VirtualCenter and ESX Server host maintains lists of authorized users, their passwords, and the permissions assigned to each user.

ESX Server and VirtualCenter use sets of privileges or roles to control which individual users or groups can access particular ESX Server objects and VirtualCenter objects. ESX Server and VirtualCenter provide a set of pre-established roles. You can also create new roles.

**Note:** You must be in Admin view for the Admin > Roles to be enabled.

You can manage users more easily by assigning them to groups. If you create groups, you can apply a role to the group, and this role is inherited by all the users in the group.

Understanding Users

A user is an individual authorized to log on to either an ESX Server host or to VirtualCenter. ESX Server users fall into two categories: those who can access the ESX Server host through VirtualCenter and those who can access the ESX Server host by directly logging on to the host from the VI Client, VI Web Access, a third-party client, or a command shell. These two categories draw users from different sources.

- **VirtualCenter users** — Authorized users for VirtualCenter are those included in the Windows domain list referenced by VirtualCenter or are local Windows users on the VirtualCenter host.

You cannot use VirtualCenter to manually create, remove, or otherwise change users. If you need to manipulate the user list or change user passwords, you must do so through the tools you normally use to manage your Windows domain.

Any changes you make to the Windows domain are reflected in VirtualCenter. Because you cannot directly manage users in VirtualCenter, the user interface doesn’t provide a user list for you to review. You see these changes only when you select users to configure permissions.

- **Direct access users** — Users authorized to work directly on an ESX Server host are those added to the internal user list by default when ESX Server is installed or by a system administrator after installation.
If you log on to the host as an administrator, you can perform a variety of management activities for these users, such as changing passwords, group memberships, permissions, and so forth. You can also add and remove users. Even if the lists maintained by an ESX Server host and VirtualCenter appear to have common users (for instance, a user called devuser), these users should be treated as separate users who have the same name. The attributes of devuser in VirtualCenter, including permissions, passwords, and so forth, are separate from the attributes of devuser on the ESX Server host. If you log on to VirtualCenter as devuser, you might have permission to view and delete files from a datastore. If you log on to an ESX Server host as devuser, you might not.

Users and groups in the Virtual Infrastructure environment are created using two methods:

• When the VI Client is connected to a VirtualCenter Server, users and groups are defined through the standard methods for Windows domains or Active Directory. You do not create users and groups for access to the VirtualCenter Server through the VI Client.
• When the VI Client is connected to an ESX Server, users and groups are defined through the Users and Groups tab.

Users and groups defined when connected to an ESX Server are applicable to that ESX Server only. They are not in the list of available users for a VirtualCenter Server connection even if the ESX Server is registered with the VirtualCenter Server.

Each ESX Server has two default users:

• The root user has full administrative privileges. Administrators use this logon and its associated password to log on to an ESX Server through the VI Client. Root users have a complete range of control activities on the specific ESX Server host that they are logged on to, including manipulating permissions, creating groups and users, working with events, and so forth.
• The vpxuser user is a VirtualCenter entity with root rights on the ESX Server host, allowing it to manage activities for that host. The vpxuser is created at the time that an ESX Server host is attached to VirtualCenter. It is not present on the ESX Server host unless the host is being managed through VirtualCenter.

Caution: Do not change vpxuser and do not change its permissions. If you do so, you might experience problems working with the ESX Server host through VirtualCenter.

For information on creating users and groups for use with your VirtualCenter Server, refer to your Microsoft documentation.
Understanding Groups

You can efficiently manage some user attributes by creating groups. A group is a set of users that you want to manage through a common set of rules and permissions. When you assign permissions to a group, they are inherited by all users in the group. Using groups can significantly reduce the time it takes to set up your permissions model.

The group lists in VirtualCenter and an ESX Server host are drawn from the same sources as the user lists. If you are working through VirtualCenter, the group list is called from the Windows domain. If you are logged on to an ESX Server host directly, the group list is called from a table maintained by the host.

The VirtualCenter Server grants access to each inventory object by assigning a role with defined privileges and a user or group to each object. Roles are a defined set of access privileges.

Individual permissions are assigned through the VirtualCenter Server or the ESX Server by pairing a user and a role and assigning this pair to an inventory object. Users and groups are created for the VirtualCenter Server through the Windows domain or Active Directory database. Users and groups are created for the ESX Server through the Users and Groups tab.

Table 3-1 lists the default roles that can be paired with a user and assigned to an object. System-level roles are permanent and cannot be changed.

Table 3-1 Default Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Role Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Access User</td>
<td>system role</td>
<td>Users cannot view or change the object. With a No Access role for a particular object, users can select the VI Client tabs associated with the no-access object, but the tab displays no content. The No Access role is the default. The root user and vpxuser are the only users not assigned the No Access role by default. They are assigned the Administrator role. Do not change the role for these users.</td>
</tr>
<tr>
<td>Read Only User</td>
<td>system role</td>
<td>Users can view the state of the object and details about the object. Users can view all the tab panels in the VI Client except the console tab. All actions through the menus and toolbars are disallowed.</td>
</tr>
<tr>
<td>Administrator</td>
<td>system role</td>
<td>Users can change privileges for an object. They can add, remove, and set access rights and privileges for all the VirtualCenter users and all the virtual objects in the Virtual Infrastructure environment.</td>
</tr>
</tbody>
</table>
Understanding Permissions

For ESX Server and VirtualCenter, a permission is defined as an access role that consists of a user and the user's assigned role for an object, such as a virtual machine or ESX Server host. Permissions grant users the right to perform specific activities and manage specific objects on an ESX Server host or, if users are working from VirtualCenter, all VirtualCenter-managed objects. For example, to configure memory for an ESX Server host, you must have host configuration permissions.

Most VirtualCenter and ESX Server users have limited ability to manipulate the objects associated with the host. However, ESX Server provides full access rights and permissions on all virtual objects, such as datastores, hosts, virtual machines, and resource pools, to two users: root and vpxuser.

- As root, you can grant permissions on an ESX Server host to individual users or groups that have been added to the ESX Server user list and group list by default when ESX Server was installed or because they were manually added to the host after installation.
- As vpxuser though VirtualCenter, you can grant permissions to any user or group included in the Windows domain list referenced by VirtualCenter.

<table>
<thead>
<tr>
<th>Role</th>
<th>Role Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Machine Admin</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: global, folder, datacenter, datastore, host, virtual machine, resource, alarm management, scheduled task, and sessions.</td>
</tr>
<tr>
<td>Datacenter Administrator</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: global, folder, datacenter, datastore, host, virtual machine, resource, alarm management, and scheduled task.</td>
</tr>
<tr>
<td>Virtual Machine Provider</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: folder, virtual machine, and resource.</td>
</tr>
<tr>
<td>Virtual Machine Power User</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: virtual machine, resource, and scheduled task.</td>
</tr>
<tr>
<td>Virtual Machine User</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: virtual machine only.</td>
</tr>
<tr>
<td>Resource Administrator</td>
<td>sample role</td>
<td>Users can perform actions on the following levels: datastore, host, virtual machine, resource, alarm management, and scheduled task. This role provides resource delegation.</td>
</tr>
</tbody>
</table>
Note: VirtualCenter registers any selected Windows domain user or group through the process of assigning permissions. By default, all users who are members of the Windows Administrators group on the VirtualCenter Server are granted the same access rights as any user assigned to the Administrator role. Users who are members of the Administrators group can log on as individuals and have full access.

The method you use to configure permissions directly on an ESX Server host is identical to the method you use to configure permissions in VirtualCenter. The list of privileges is the same for both ESX Server and VirtualCenter. The abbreviations used in Table 3-2 are VC-VirtualCenter Server, HC-Host Client/ESX Server.

### Table 3-2 Table of Permissions and Roles

<table>
<thead>
<tr>
<th>Privilege Category</th>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alarm Management</td>
<td>Create Alarm</td>
<td>Create a new alarm. <strong>User interface element</strong> — alarm tab context menu, file menu</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Delete Alarm</td>
<td>Delete an existing alarm. <strong>User interface element</strong> — alarm tab context menu, file menu</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Modify Alarm</td>
<td>Change the properties of an existing alarm. <strong>User interface element</strong> — alarm tab context menu, file menu</td>
<td>VC only</td>
</tr>
<tr>
<td>Permissions</td>
<td>Modify Permission</td>
<td>Define one or more permission rules on an entity, or updates rules if already present for the given user or group on the entity. <strong>User interface element</strong> — all items in permissions tab context menu, all items in Inventory &gt; Permissions file menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Modify Role</td>
<td>Updates a role's name and/or the privileges. <strong>User interface element</strong> — roles tab context menu, toolbar button, file menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Reassign Role Permissions</td>
<td>Reassigns all permissions of a role to another role. <strong>User interface element</strong> — Delete Role dialog box radio button and associated menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Datacenter</td>
<td>Create Datacenter</td>
<td>Create a new datacenter. &lt;br&gt;<strong>User interface element</strong> — inventory context menu, toolbar button, and File &gt; New Datacenter</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Delete Datacenter</td>
<td>Removes a datastore. &lt;br&gt;<strong>User interface element</strong> — inventory context menu, Inventory &gt; Datacenter &gt; Remove, Edit &gt; Remove</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Move Datacenter</td>
<td>Move a datacenter. &lt;br&gt;<strong>User interface element</strong> — inventory drag and drop</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Rename Datacenter</td>
<td>Change the name of a datacenter. &lt;br&gt;<strong>User interface element</strong> — inventory object, inventory context menu, Edit &gt; Rename, Inventory &gt; Datacenter &gt; Rename</td>
<td>VC only</td>
</tr>
<tr>
<td>Datastore</td>
<td>Browse Datastore</td>
<td>Browse files on a datastore. &lt;br&gt;<strong>User interface element</strong> — Add existing disk, browse for CD-ROM or Floppy media, serial or parallel port files</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Delete Datastore</td>
<td>Removes a datastore. &lt;br&gt;<strong>User interface element</strong> — inventory datastore context menu, Edit &gt; Remove, Inventory &gt; Datastore &gt; Remove</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Delete datastore File</td>
<td>Delete a file in the datastore. &lt;br&gt;<strong>User interface element</strong> — Datastore Browser toolbar button and context menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Rename Datastore</td>
<td>Renames a datastore. &lt;br&gt;<strong>User interface element</strong> — &lt;datastore&gt; Properties dialog Change button, host summary tab context menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Folder</td>
<td>Create Folder</td>
<td>Create a new folder. &lt;br&gt;<strong>User interface element</strong> — taskbar button, file menu, context menu</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Delete Folder</td>
<td>Delete a folder. &lt;br&gt;<strong>User interface element</strong> — file menu, context menu</td>
<td>VC only</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>Move Folder</td>
<td>Move a folder</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Inventory (drag)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rename Folder</td>
<td>Change the name of a folder</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — inventory pane object text field, context menu, file menu</td>
<td></td>
</tr>
<tr>
<td>Global</td>
<td>Cancel Task</td>
<td>Cancel a running or queued task</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Recent tasks pane context menu, Tasks &amp; Events context menu Can currently cancel clone and clone to template.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Diagnostics</td>
<td>Get list of diagnostic files, log header, binary files, or diagnostic bundle.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — File &gt; Export &gt; Export Diagnostic Data, Admin System Logs tab</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Licenses</td>
<td>See what licenses are installed and add/remove licenses.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Licenses tab, Configuration &gt; Licensed Features</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Log Event</td>
<td>Logs a user defined event against a particular managed entity.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Should ask for a reason when shutting down or rebooting a host;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Manage Custom Properties</td>
<td>Add, remove, rename custom fields for a managed entity.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Administration &gt; Custom Attributes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Set Custom Properties</td>
<td>View, create, and remove custom fields.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Any list view shows the fields defined and allows setting them</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Settings</td>
<td>Read and modify run-time VC configuration settings.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Administration &gt; VMware VirtualCenter Settings file menu</td>
<td></td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>VC Server</td>
<td>Prepare or initiate a VMotion send operation or a VMotion receive operation. There are no user VI Client interface elements associated with this privilege.</td>
<td>VC only</td>
<td></td>
</tr>
<tr>
<td>Host &gt; Configuration &gt; Advanced Configuration</td>
<td>Set advanced options in host configuration User interface element — Host Config &gt; Advanced Settings, Inventory hierarchy context menu</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Change SNMP Settings</td>
<td>Edit, restart, and stop SNMP agent. There are no user VI Client interface elements associated with this privilege.</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Connection</td>
<td>Change the connection status of a host (connected or disconnected). User interface element — right-click Host</td>
<td>VC only</td>
<td></td>
</tr>
<tr>
<td>HyperThreading</td>
<td>Enable/disable hyperthreading in the host CPU scheduler. User interface element — Host Config &gt; Processors</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Internet Service</td>
<td>Enable/disable internet services provided by service console, such as SSH, Telnet, SNMP, etc. User interface element — Host Config &gt; Security Profile</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Maintenance</td>
<td>Put the host in and out of maintenance mode, shutdown/restart the host, or restart the VirtualCenter agent on the host. User interface element — Host context menu, Inventory &gt; Host &gt; Enter Maintenance Mode</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Memory Configuration</td>
<td>Set configured service console memory reservation. User interface element — Host Config &gt; Memory</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Network Configuration</td>
<td>Network, firewall, and VMotion network configuration. User interface element — Host Config &gt; Networking, Network Adapter, DNS and Routing</td>
<td>HC and VC</td>
<td></td>
</tr>
</tbody>
</table>
### Storage Partition Configuration

Manage VMFS datastore and diagnostic partitions. Scan for new storage devices. Manage iSCSI.

**User interface element** — Host Config > Storage, Storage Adapters, Host Configuration tab datastore context menu

### System Resource Settings

Update the configuration of the system resource hierarchy.

**User interface element** — Host Config > System Resource Allocation

### Virtual Machine Auto-start Configuration

Change auto-start and auto-stop order of virtual machines on a single host.

**User interface element** — Host Config > Virtual Machine Startup/Shutdown

### Privilege Table

<table>
<thead>
<tr>
<th>Privilege Category</th>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Partition Configuration</td>
<td>Manage VMFS datastore and diagnostic partitions. Scan for new storage devices. Manage iSCSI.</td>
<td><strong>User interface element</strong> — Host Config &gt; Storage, Storage Adapters, Host Configuration tab datastore context menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td>System Resource Settings</td>
<td>Update the configuration of the system resource hierarchy.</td>
<td><strong>User interface element</strong> — Host Config &gt; System Resource Allocation</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Virtual Machine Auto-start Configuration</td>
<td>Change auto-start and auto-stop order of virtual machines on a single host.</td>
<td><strong>User interface element</strong> — Host Config &gt; Virtual Machine Startup/Shutdown</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Host &gt; Inventory Add Host To Cluster</td>
<td>Add a host to an existing cluster.</td>
<td><strong>User interface element</strong> — inventory context menu</td>
<td>VC only</td>
</tr>
<tr>
<td>Add stand-alone Host</td>
<td>Add a stand-alone host.</td>
<td><strong>User interface element</strong> — toolbar button, inventory context menu, inventory &gt; Datacenter &gt; Add Host, File &gt; New &gt; Add Host, host tab context menu</td>
<td>VC only</td>
</tr>
<tr>
<td>Create Cluster</td>
<td>Create a new cluster.</td>
<td><strong>User interface element</strong> — toolbar button, inventory context menu, inventory &gt; Datacenter &gt; New Cluster, File &gt; New &gt; Cluster</td>
<td>VC only</td>
</tr>
<tr>
<td>Delete Cluster</td>
<td>Delete a cluster or stand-alone host.</td>
<td><strong>User interface element</strong> — inventory context menu, Edit &gt; Remove, Inventory &gt; Cluster &gt; Remove</td>
<td>VC only</td>
</tr>
<tr>
<td>Modify Cluster</td>
<td>Change the properties of a cluster.</td>
<td><strong>User interface element</strong> — inventory context menu, Inventory &gt; Cluster &gt; Edit Settings, Summary tab</td>
<td>VC only</td>
</tr>
<tr>
<td>Move Cluster</td>
<td>Move a cluster between folders</td>
<td><strong>User interface element</strong> — inventory hierarchy</td>
<td>VC only</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Move Host</td>
<td></td>
<td>Moves a set of existing hosts into a cluster.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Inventory hierarchy drag and drop</td>
<td></td>
</tr>
<tr>
<td>Remove Host From Cluster</td>
<td></td>
<td>Destroy a host in a cluster.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — inventory drag and drop out of cluster, context menu, Inventory &gt; Host &gt; Remove</td>
<td></td>
</tr>
<tr>
<td>Rename Cluster</td>
<td></td>
<td>Rename a cluster.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — inventory single click, inventory hierarchy context menu, Inventory &gt; Cluster &gt; Rename</td>
<td></td>
</tr>
<tr>
<td>Host &gt; Local Operations</td>
<td>Create Virtual Machine</td>
<td>Creates a new virtual machine from scratch on a disk without registering it on the host. There are no user VI Client interface elements associated with this privilege.</td>
<td>HC only</td>
</tr>
<tr>
<td>Delete Virtual Machine</td>
<td></td>
<td>Delete a virtual machine on disk, whether registered or not. There are no user VI Client interface elements associated with this privilege.</td>
<td>HC only</td>
</tr>
<tr>
<td>Install Agent</td>
<td></td>
<td>Install/uninstall various agents on a host, for example, vpxa and aam. There are no user VI Client interface elements associated with this privilege.</td>
<td>HC only</td>
</tr>
<tr>
<td>Manage User Groups</td>
<td></td>
<td>Manage local accounts on a host</td>
<td>HC only</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Users &amp; Groups tab (only present if the VI Client logs on to the host directly).</td>
<td></td>
</tr>
<tr>
<td>Network</td>
<td>Delete Network</td>
<td>Removes a network. <strong>User interface element</strong> — inventory network context menu, Edit &gt; Remove, Inventory &gt; Network &gt; Remove</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Performance</td>
<td>Modify Intervals</td>
<td>Create, remove, and update performance data collection intervals. <strong>User interface element</strong> — VC Settings &gt; Statistics</td>
<td>VC only</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Resource</td>
<td>Apply Recommendation</td>
<td>Ask the server to go ahead with a suggested VMotion.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — Cluster Migrations tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Assign Virtual Machine To Pool</td>
<td>Assign virtual machines to a resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — VM creation wizard</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cold Migrate</td>
<td>Migrates a virtual machine's execution to a specific resource pool or host.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — inventory context menu, VM Summary tab, Inventory &gt; VM &gt; Migrate, drag and drop</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Create Pool</td>
<td>Create a new resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — file menu, context menu, Summary tab, Resources tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Pool</td>
<td>Delete a resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — Edit &gt; Remove, Inventory &gt; Resource Pool &gt; Remove, inventory context menu, Resources tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hot Migrate</td>
<td>Migrates a virtual machine's execution to a specific resource pool or host.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — inventory context menu, VM Summary tab, Inventory &gt; VM &gt; Migrate, drag and drop</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modify Pool</td>
<td>Change the allocations of a resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — Inventory &gt; Resource Pool &gt; Remove, Resources tab</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Move Pool</td>
<td>Move a resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — drag and drop</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Query VMotion</td>
<td>Investigates the general VMotion compatibility of a virtual machine with a set of hosts.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td><strong>User interface element</strong> — Required when bringing up the migration wizard for a powered-on VM, to check compatibility</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Privilege Category

<table>
<thead>
<tr>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rename Pool</td>
<td>Rename a resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Scheduled Task</td>
<td>Create Tasks</td>
<td>VC only</td>
</tr>
<tr>
<td>Scheduled Task</td>
<td>Delete Task</td>
<td>VC only</td>
</tr>
<tr>
<td>Scheduled Task</td>
<td>Modify Task</td>
<td>VC only</td>
</tr>
<tr>
<td>Scheduled Task</td>
<td>Run Task</td>
<td>VC only</td>
</tr>
<tr>
<td>Sessions</td>
<td>Global Message</td>
<td>VC only</td>
</tr>
<tr>
<td>Sessions</td>
<td>Terminate Session</td>
<td>VC only</td>
</tr>
<tr>
<td>Virtual Machine Configuration</td>
<td>Add Existing Disk</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Virtual Machine Configuration</td>
<td>Add New Disk</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Virtual Machine Configuration</td>
<td>Add or Remove Device</td>
<td>HC and VC</td>
</tr>
</tbody>
</table>

### Privilege Name Details

- **User interface element**
  - **Scheduled Tasks toolbar button and context menu**
  - **Inventory > Resource Pool > Rename, single-click, context menu**
  - **Inventory > Scheduled Task > Remove, Edit > Remove**
  - **Inventory > Scheduled Tasks > Edit, Scheduled Tasks tab context menu**
  - **Sessions tab, Administration > Edit Message of the Day**
  - **Sessions tab**
  - **Virtual Machine Configuration**
  - **VM Configuration**
### Privilege Table

<table>
<thead>
<tr>
<th>Privilege Category</th>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advanced</td>
<td>Change CPU Count</td>
<td>Change the number of virtual CPUs.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration Wizard &gt; Options tab &gt; Advanced - look for Configuration Parameters button</td>
<td></td>
</tr>
<tr>
<td>Change Resource</td>
<td></td>
<td>Changes resource configuration of a set of VM nodes in a given resource pool.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration &gt; Resources tab</td>
<td></td>
</tr>
<tr>
<td>Disk Lease</td>
<td></td>
<td>Lease disks for Disk Manager</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There are no user VI Client interface elements associated with this privilege.</td>
<td></td>
</tr>
<tr>
<td>Memory</td>
<td></td>
<td>Change the amount of memory allocated to the VM.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration &gt; Memory</td>
<td></td>
</tr>
<tr>
<td>Modify Device</td>
<td>Settings</td>
<td>Change the properties of an existing device.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>User interface element — VM Configuration - SCSI/IDE node selection</td>
<td></td>
</tr>
<tr>
<td>Raw Device</td>
<td></td>
<td>Add or remove a raw disk mapping or SCSI passthrough device.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration &gt; Add/Remove raw disk mapping</td>
<td></td>
</tr>
<tr>
<td>Remove Disk</td>
<td></td>
<td>Remove a virtual disk device.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration &gt; Hard Disk (but not a raw disk mapping)</td>
<td></td>
</tr>
<tr>
<td>Rename</td>
<td></td>
<td>Rename a virtual machine.</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>User interface element</td>
<td>VM Configuration, inventory, inventory context menu, file menu, inventory menu</td>
<td></td>
</tr>
<tr>
<td>Reset Guest Info</td>
<td></td>
<td>Clears guestinfo variables</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td></td>
<td>There are no user VI Client interface elements associated with this privilege.</td>
<td></td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Settings</td>
<td>Change general VM settings.</td>
<td>User interface element — VM Configuration &gt; Options tab (except VM name)</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Upgrade Virtual Hardware</td>
<td>Upgrade the virtual machine’s virtual hardware version from a previous version of VMware.</td>
<td>User interface element — context menu, file menu (only appears if vmx file shows a lower configuration number)</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Virtual Machine &gt; Interaction</td>
<td>Answer Question</td>
<td>Resolve issues with VM state transitions or runtime errors.</td>
<td>User interface element — Summary tab, inventory menu, context menu</td>
</tr>
<tr>
<td>Console Interaction</td>
<td>Interact with the virtual machine’s virtual mouse, keyboard, and screen; get screenshot information.</td>
<td>User interface element — Console tab, toolbar button, Inventory &gt; Virtual Machine &gt; Open Console, inventory context menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Device Connection</td>
<td>Change the connected state of a virtual machine’s disconnectable virtual devices.</td>
<td>User interface element — VM Configuration</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Power Off</td>
<td>Power off a powered-on virtual machine, shutdown guest.</td>
<td>User interface element — file menu item, context menu, pop-up console menu, toolbar button, summary tab</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Power On</td>
<td>Power on a powered-off virtual machine, resume a suspended virtual machine.</td>
<td>User interface element — file menu item, context menu, pop-up console menu, toolbar button, summary tab</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Reset</td>
<td>Reset VM, reboot guest.</td>
<td>User interface element — file menu item, context menu, pop-up console menu, toolbar button, summary tab</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------</td>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>Set CD Media</td>
<td>Change backing of a CD-ROM device. <strong>User interface element</strong> — VM Configuration &gt; DVD/CD-ROM</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Set Floppy Media</td>
<td>Change backing of a floppy device. <strong>User interface element</strong> — VM Configuration</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Suspend</td>
<td>Suspend a powered-on virtual machine, put guest in standby mode. <strong>User interface element</strong> — file menu item, context menu, pop-up console menu, toolbar button, summary tab</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Tools Install</td>
<td>Mount/unmount the VMware Tools CD installer as a CD-ROM for the guest operating system. <strong>User interface element</strong> — file menu item, context menu, pop-up console menu</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Virtual Machine &gt; Inventory</td>
<td>Create</td>
<td>Create a new virtual machine and allocate resources for it’s execution. See also Host.Local.CreateVM <strong>User interface element</strong> — file menu, context menu, summary tab - New Virtual Machine links</td>
<td>HC and VC</td>
</tr>
<tr>
<td>Delete</td>
<td>Delete a virtual machine, optionally removing underlying files from disk. Must be present on parent folder of VM. See also Host.Local.DeleteVM <strong>User interface element</strong> — file menu, context menu, summary tab</td>
<td>HC and VC</td>
<td></td>
</tr>
<tr>
<td>Move</td>
<td>Relocate a virtual machine in the hierarchy. Existing VM and privilege must be present on both the source and destination VM folders. <strong>User interface element</strong> — inventory hierarchy drag and drop in Virtual Machines &amp; Template view</td>
<td>VC only</td>
<td></td>
</tr>
<tr>
<td>Virtual Machine &gt; Provisioning</td>
<td>Allow Disk Access</td>
<td>Open a disk on a virtual machine for random read/write access. Used mostly for remote disk mounting. There are no user VI Client interface elements associated with this privilege.</td>
<td>n/a</td>
</tr>
<tr>
<td>Privilege Category</td>
<td>Privilege Name</td>
<td>Description</td>
<td>Affects</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td></td>
<td>Allow Read Only Disk Access</td>
<td>Open a disk on a virtual machine for random read access. Used mostly for remote disk mounting. There are no user VI Client interface elements associated with this privilege.</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>Allow Virtual Machine Files Download</td>
<td>Read files associated with a virtual machine, including vmx, disks, logs and nvrn. There are no user VI Client interface elements associated with this privilege.</td>
<td>VC, HC</td>
</tr>
<tr>
<td></td>
<td>Allow Virtual Machine Files Upload</td>
<td>Write files associated with a virtual machine, including vmx, disks, logs and nvrn. There are no user VI Client interface elements associated with this privilege.</td>
<td>VC, HC</td>
</tr>
</tbody>
</table>
|                    | Clone                           | Clone an existing virtual machine and allocate resources.  
**User interface element** — file menu, context menu, Summary tab                                                 | VC only |
|                    | Clone Template                  | Clone a template.  
**User interface element** — file menu, context menu, Virtual Machines tab                                                                   | VC only |
|                    | Create Template From Virtual Machine | Creates a new template from a virtual machine.  
**User interface element** — “Clone to template…” file menu, context menu, Summary tab items                                              | VC only |
|                    | Customize                       | Customize a virtual machine’s guest operating system without moving the VM.  
**User interface element** — Clone Virtual Machine Wizard: Guest Customization                                                                  | VC only |
|                    | Deploy Template                 | Creates a new virtual machine from a template.  
**User interface element** — “Deploy to template” file menu, context menu items, Virtual Machines tab                                     | VC only |
|                    | Mark As Template                | Mark an existing, powered on VM as a template.  
**User interface element** — “Convert to template…” file menu, context menu items, Virtual Machines tab, Summary tab | VC only |
<table>
<thead>
<tr>
<th>Privilege Category</th>
<th>Privilege Name</th>
<th>Description</th>
<th>Affects</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Mark As Virtual</td>
<td>Mark an existing template (not residing on VC server) as a VM.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Machine</td>
<td><strong>User interface element</strong> — “Convert to Virtual Machine...” file menu, context menu items, Virtual Machines tab</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — Customization Specifications Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Modify Customization</td>
<td>Create, modify, or delete customization specifications.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Specs</td>
<td><strong>User interface element</strong> — Customization Specifications Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read Customization</td>
<td>View the customization specifications defined on the system.</td>
<td>VC only</td>
</tr>
<tr>
<td></td>
<td>Specs</td>
<td><strong>User interface element</strong> — Edit &gt; Customization Specifications</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Virtual Machine &gt;</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>State</td>
<td><strong>User interface element</strong> — context menu, toolbar button, inventory menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Create Snapshot</td>
<td>Create a new snapshot from the virtual machine's current state.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — context menu, toolbar button, inventory menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Remove Snapshot</td>
<td>Remove a snapshot from the snapshot history.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — context menu, toolbar button, inventory menu</td>
<td>HC and VC</td>
</tr>
<tr>
<td></td>
<td>Rename Snapshot</td>
<td>Rename this snapshot with either a new name or a new description or both.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>There are no user VI Client interface elements associated with this privilege.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Revert To Snapshot</td>
<td>Set the VM to the state it was in at a given snapshot.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>User interface element</strong> — context menu, toolbar button, inventory menu Virtual Machines tab</td>
<td></td>
</tr>
</tbody>
</table>
Understanding Roles

VirtualCenter and ESX Server grant access to objects only to users who have been assigned permissions for the object. When you assign a user or group permissions for the object, you do so by pairing the user or group with a role. A role is a predefined set of privileges.

ESX Server hosts provide three default roles, and you cannot change the privileges associated with these roles. Each subsequent role includes the privileges of the previous role.

- **No Access User** — Users assigned this role for an object cannot view or change the object. For example, a user who has a No Access role for a particular virtual machine cannot see the virtual machine in the VI Client inventory when he or she logs on to the ESX Server host. With a No Access role for a particular object, a user can select the VI Client tabs associated with the no-access object, but the tab displays no content. For example, if the user doesn’t have access to any virtual machines, he or she can select the Virtual Machines tab but won’t see a virtual machine listing on the tab or any status information. The table is blank.

  The No Access role is the default assigned to any user or group you create on an ESX Server host. You can elevate or lower a newly created user’s or group’s role on an object-by-object basis.

- **Read Only User** — Users assigned this role for an object are allowed to view the state of the object and details about the object.

  This user can view virtual machine, host, and resource pool attributes, that is, all the tab panels in the VI Client except the Console tab. The user cannot view the remote console for a host. All actions through the menus and toolbars are disallowed.

- **Administrator** — Users assigned this role for an object are allowed to view and perform all actions on the object.

Create new roles using the role-editing facilities in the VI Client to create privilege sets that match your user needs. If you use the VI Client connected to VirtualCenter to manage your ESX Server hosts, you have additional roles to choose from VirtualCenter. The roles you create directly on an ESX Server host are not accessible within VirtualCenter. You can work with these roles only if you log on to the host directly from the VI Client.
Planning Access Permission

For each object in the Virtual Infrastructure hierarchy, determine the permissions for each Virtual Infrastructure user and group.

Typically, lower level permission roles are assigned at higher level locations in the hierarchy. As you move down into the branches of the hierarchy, users and groups permissions start to differentiate: some users and groups require higher permission roles in some branches, while other users and groups require higher permission roles in other branches.

Note: Several users may access the VirtualCenter Server from different Virtual Infrastructure Clients at the same time. Virtual Infrastructure does not explicitly restrict users with the same login and password from accessing and taking action within the Virtual Infrastructure environment.

Remove users from the Windows Domain Controller or Active Directory, and they lose permissions to all objects in the Virtual Infrastructure system on their next attempts at login. Users that are currently logged in and are removed from the Windows databases retain their Virtual Infrastructure permissions as long as they remain logged in. After they log out, they can no longer access the Virtual Infrastructure system. Individual permissions, or those granted as part of inclusion in another group, are not affected.

Change a user’s name in the Windows Domain Controller or Active Directory, and the existing user name becomes invalid in the Virtual Infrastructure system. The same methodology applies to groups, but this applies to a group only after VirtualCenter Server has been restarted.

For more information, see the online help files.
This chapter contains the following information about creating and working with templates.

- Creating and Working With Virtual Machines on page 60
- Creating New Virtual Machines on page 61
- VMware Tools on page 65
- Datastores on page 72
- Templates on page 75
- Virtual Machine Properties Editor on page 77
Creating and Working With Virtual Machines

When you looked at inventory in the previous section, you found that a number of virtual machines were already running in that host. This section gives an overview of adding and powering on a virtual machine. For more information, see the VI Client Online Help.

To create and start a virtual machine:

1. Start the VI client, and make sure Hosts and Cluster are displayed in the inventory panel.

2. Right-click a host and choose New Virtual Machine.

3. The New Virtual Machine Wizard steps you through virtual machine creation. See the VI Client Online Help for detailed information.

4. After you've created a virtual machine, you can power it on by clicking the icon in the information panel's command panel or by using the right-button menu. Notice that the available right-button menu options change depending on the state of the virtual machine.
At times, the system might not allow you to power on a virtual machine because the host's resources have already been reserved. In that case, you can select the host's resource allocation tab to see who is using resources and what resources are still available. Resource allocation is discussed in detail in the Resource Management Guide.

Creating New Virtual Machines

The VI Client provides a simple and flexible user interface from which you can create new virtual machines either through manual configuration, from templates, or by cloning existing virtual machines. All virtual machines are created in place using a
wizard that guides you through the steps to produce a complete and working virtual machine.

Figure 5-1 shows the flow of a Typical virtual machine creation.

Figure 4-2  Creation of a Virtual Machine Using the Typical Path
Figure 5-2 shows the flow of a Custom virtual machine creation.
The process of creating a virtual machine includes selecting the specific type of virtual machine creation that you want from either the main or object context menus. Depending on the selection, you see a slightly different set of screens tailored for the particular process you chose. Any choices that are not applicable are disabled. For example, **Clone** is disabled if there are no virtual machines in your inventory. In all cases, the widest range of choices is available for optimal flexibility. See the online help files for information on creating virtual machines using the Create New Virtual Machine Wizard.

**Migration Issues**

**Virtual Machine Compatibility**

Migrating a Linux virtual machine from ESX Server 3 to ESX Server 2.x prevents the virtual machine from running until the old CMOS is replaced with a new one. The following message is displayed: “The CMOS of this virtual machine is incompatible with the current version of VMware ESX server. A new CMOS with default values will be used instead.”

**Mapping a SAN LUN**

When you create a virtual machine, one of the options is to map a SAN LUN. Instead of storing virtual machine data in a virtual disk file, you can store the data directly on a SAN LUN. This is useful if you are running applications in your virtual machines that need visibility to the physical characteristics of the storage device.

When you map a LUN to a VMFS volume, VI Client creates a mapping file that points to the raw LUN. Encapsulating disk information in a file allows VI Client to lock the LUN so that only one virtual machine can write to it.

This mapping file has a `.vmdk` extension, but the file contains only disk information describing the mapping to the LUN on the ESX Server system. The actual data is stored on the LUN.

**Note:** Using VI Client, you cannot deploy a virtual machine from a template and store its data on a LUN. When you deploy a virtual machine from a template, you can store its data in a virtual disk file.

A compatibility mode is either physical or virtual.

- Physical compatibility mode allows the guest operating system to access the hardware directly. Physical compatibility is useful if you are using SAN-aware applications in the virtual machine.
Virtual compatibility mode allows the virtual machine to use VMware snapshots and other advanced functionality. Virtual compatibility allows the LUN to behave as if it were a virtual disk, so you can use features like disk modes. However, a LUN configured for physical compatibility cannot be cloned, made into a template, or migrated if the migration involves copying the disk.

When you clone the disk, make a template out of it, or migrate it (if the migration involves copying the disk). The contents of the LUN are copied into a virtual disk (.vmdk) file.

**Power State Exceptions**

If the physical machine on which your virtual machines reside crashes or loses power while saving a checkpoint, that checkpoint file might be corrupted. If you try to resume the virtual machine from that checkpoint file, the vmx will crash while trying to load it. You must delete the checkpoint file before trying to power on the virtual machine again. Remove the .vmss file and restart the virtual machine.

**NIC Morphing**

In ESX Server 3, the virtual vlance hardware is NIC morphing hardware. It looks like a vlance device to a regular pcnet32 driver but looks like a vmxnet device to a vmxnet driver. The vmxnet NIC appears as a vlance device but morphs on the fly to vmxnet. This is for ease of use and driver signing.

**To install the vmxnet driver**

1. Uninstall the pcnet32 driver so that the hardware resources are free for the vmxnet driver.
2. Install the vmxnet driver.
   
   Previously, a device was either vmxnet or vmlance. A virtual machine was created with vlance, and then the tools were installed. The tools did not recognize the vmxnet driver, so the driver was not loaded.
3. Power off the virtual machine.
4. Add a vmxnet device.
5. Power on the virtual machine.
6. Run tools-config again to pickup the vmxnet driver.

**VMware Tools**

VMware Tools is a suite of utilities that enhances the performance of the virtual machine's guest operating system and improves management of the virtual machine.
For more information about installing a guest operating system in your virtual machine, see the Guest Operating System Customization Guide.

**Note:** It is important that you install VMware Tools in the guest operating system. Although the guest operating system can run without VMware Tools, you lose important functionality and convenience mentioned in the list below.

When you install VMware Tools, you install:

- VMware Tools service (or `vmware-guestosd` on Linux guests).
- Set of VMware device drivers, including the following:
  - SVGA display driver
  - `vmxnet`: networking driver for some guest operating systems
  - BusLogic SCSI driver for some guest operating systems
  - Memory control driver for efficient memory allocation between virtual machines
  - Sync driver to quiesce I/O for Consolidated Backup
  - VMware mouse driver
- VMware Tools control panel that lets you modify settings, shrink virtual disks, and connect and disconnect virtual devices.
- Scripts that help you to automate guest operating system operations. The scripts run when the virtual machine’s power state changes.
- Component that supports copying and pasting text between the guest and managed host operating systems in Microsoft Windows guest operating systems. The copy and paste option is not supported in Linux guest operating systems.

Configure the guest operating system before installing or reinstalling VMware Tools. This enables VMware tools to determine the correct mouse configuration and module configuration.

**Caution:** If the guest operating system is installed but not correctly configured when you install VMware Tools, the VMware Tools installation does not work correctly. This can cause the guest operating system to crash.

**Installing or Upgrading VMware Tools**

The installers for VMware Tools for Windows, Linux, and NetWare guest operating systems are built into ESX Server as ISO image files.
Chapter 4 Working with Virtual Machines

Note: If you do not have VMware Tools installed in your virtual machine, you cannot use the shutdown or restart options. You can only use the Power options. To shut down the guest operating system, do it from within the virtual machine console before you power down the virtual machine.

To install or upgrade VMware Tools

1. From the VI Client, power on the virtual machine.
2. When the guest operating system starts, select Virtual Machines > Install VMware Tools.
3. From inside the virtual machine, click Yes to launch the InstallShield Wizard.
   - If you have autorun enabled in your guest operating system (the default setting for Windows operating systems), a dialog box appears.
   - If autorun is not enabled, run the VMware Tools installer. Click Start > Run and enter D:\setup.exe where D: is your first virtual CD-ROM drive.
4. Follow the onscreen instructions.
   - On Windows Server 2003, the SVGA driver is installed automatically, and the guest operating system uses it after it reboots.
   - After you install VMware Tools, reboot Windows 2000 and Windows XP guest operating systems to use the new driver.

Mass VMware Tools Upgrade

In ESX Server 3, you can upgrade VMware Tools and virtual hardware for multiple virtual machines without interacting with the virtual machine from the virtual machine console. This feature allows you to upgrade VMware Tools and virtual hardware for one or more virtual machine from earlier releases.

Requirements

The following are VMware Tools requirements:

- Only virtual machines managed by VirtualCenter 2 can be upgraded.
- Mass upgrades are only available for Microsoft Windows 2000 and above.
- Windows NT and Linux are not supported.
- The virtual disk must be on a VMFS-3 volume.
- Virtual machines must be powered off.
- Because the mass upgrades command-line tool is installed as part of the VirtualCenter 2 server installation and run on VirtualCenter Server, the upgrader runs on Microsoft Windows only.
Doing a Mass Upgrade of Tools and Virtual Hardware on Multiple Virtual Machines

The upgrade tool, available from the VirtualCenter installation directory, can be used only from the command line with the following options.

Command:

```
vmware-vmupgrade.exe -u user [-p password] [-n vmname] [-h host]
[-m maxpowerons] [-s] [-q]
```

Table 4-1 describes the options available with the upgrade command.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>-u user</td>
<td>Specifies a user with sufficient privileges on the target virtual machine,</td>
</tr>
<tr>
<td></td>
<td>Machine.Provisioning.*</td>
</tr>
<tr>
<td>-p password</td>
<td>Specifies a password on the command line. If omitted, the tool prompts</td>
</tr>
<tr>
<td></td>
<td>for a password.</td>
</tr>
<tr>
<td>-n vmname</td>
<td>The name of the virtual machine to upgrade. This name corresponds to the</td>
</tr>
<tr>
<td></td>
<td>display name of a virtual machine. Specify multiple virtual machines</td>
</tr>
<tr>
<td></td>
<td>using multiple -n parameters. The -n option is ignored if -h is specified.</td>
</tr>
<tr>
<td>-h host</td>
<td>Attempts to upgrade all the virtual machines on a particular host. Fails if</td>
</tr>
<tr>
<td></td>
<td>the specified host is not version ESX 3.0 or greater.</td>
</tr>
<tr>
<td>-m maxpowerons</td>
<td>On a particular host, only power-on maxpowerons virtual machines at a</td>
</tr>
<tr>
<td></td>
<td>time.</td>
</tr>
<tr>
<td>-t maxpowerontime</td>
<td>After the tools upgrade is scheduled on a virtual machine, the virtual</td>
</tr>
<tr>
<td></td>
<td>machine is powered on and allowed to run through the tools installation</td>
</tr>
<tr>
<td></td>
<td>process. In most cases, the guest powers down the machine automatically</td>
</tr>
<tr>
<td></td>
<td>when the process completes. This parameter allows a user to set the</td>
</tr>
<tr>
<td></td>
<td>maximum amount of time for a virtual machine to be powered on in case the</td>
</tr>
<tr>
<td></td>
<td>guest is unable to shut down the machine.</td>
</tr>
<tr>
<td>-s</td>
<td>Skips the tools and does only the virtual hardware upgrade.</td>
</tr>
<tr>
<td>-q</td>
<td>Works quietly. Doesn't produce status or completion messages on stdout.</td>
</tr>
</tbody>
</table>

VMware Tools Properties

When VMware Tools is installed in your virtual machine, a VMware Tools icon is displayed in the virtual machine’s system tray.

Requirements

The following are VMware Tools requirements:
• Shrink disk is not supported.
• For Microsoft Windows NT, the default scripts for suspend and resume do not work.
• The mouse driver installation fails in X Windows versions older than 4.2.0.

To display the VMware Tools Properties dialog box

1. Double-click the VMware Tools icon in the system tray from inside the guest operating system.

The VMware Tools Properties dialog box appears with the Options tab displayed.

![Figure 4-4 VMware Tools Properties Dialog Box: Options Tab](image)

**Options Tab**

From this tab you can synchronize the time between the guest and service console and show VMware Tools in the taskbar. The guest service can synchronize the date and time in the guest operating system with the time in the service console once every minute.

To synchronize the time between the guest and service console

1. In the VMware Tools control panel, click the Other tab (Options in a Linux guest).
2. Select **Time synchronization between the virtual machine and the host operating system**.
The guest service can synchronize the date and time in the guest with the service console in response to various system events, for example, when you resume from disk. Disable this feature in the configuration file by setting:

\[
\text{time.synchronize.resume.disk} = \text{FALSE}
\]

3. Click **Apply**.

4. To show VMware Tools in the taskbar, select the check box and click **Apply**.

5. Click **OK** to exit the Properties dialog box.

**Devices Tab**

You can connect a device to a virtual machine using the devices tab.

To connect a device to the virtual machine

1. Click the **Devices** tab.

2. Select the check box for the device you want to connect.

   ![Figure 4-5 VMware Tools Properties Dialog Box: Devices Tab](image)

3. Click **Apply**.

4. Click **OK** to exit the Properties dialog box.

**Scripts Tab**

Through VMware Tools you can run scripts that execute when you change the power state of your virtual machine: power on, power off, suspend, or resume the virtual machine.

A default script for each power state is located in the guest operating system in

\[
C:\Program Files\VMware
\]
Table 4-2 lists the scripts to run to perform the power action.

Table 4-2 Power States and Scripts.

<table>
<thead>
<tr>
<th>When You …</th>
<th>This Default Script Runs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suspend the guest operating system</td>
<td>suspend-vm-default.bat</td>
</tr>
<tr>
<td>Resume the guest operating system</td>
<td>resume-vm-default.bat</td>
</tr>
<tr>
<td>Shut down the guest operating system</td>
<td>poweroff-vm-default.bat</td>
</tr>
<tr>
<td>Power on the guest operating system</td>
<td>poweron-vm-default.bat</td>
</tr>
</tbody>
</table>

To run a script event

1. Click the Scripts tab.
2. Choose a power operation from the Script Event drop-down menu.
3. To select a different script, click Custom Script, click Browse, and select the new script.
   After you select a script, you can edit it or run it to test it.
4. To edit a script, click Edit.
   The script opens in your default editor. Make your changes.
5. To test the script, click Run Now.
6. To disable the running of a script, deselect the Use Script check box.
7. Click Apply to save your settings.
8. Click **OK** to exit the properties dialog box.

**About Tab**

The About tab contains information about VMware Tools, such as the build number.

**Datastores**

A datastore is a new global object type that is managed within the Inventory list in VirtualCenter and the VI Client. A datastore provides storage for a managed host and is the location for stored virtual machines.

This option in the Inventory navigation button menu displays the list of available datastores. This option is available only when connected to a VirtualCenter Server. The datastore activities include:

- Browse the datastore
- Remove the datastore

**Note:** If you rename a datastore on a host client that is managed by VirtualCenter and then attempt to create a virtual machine in that datastore using VirtualCenter, the name of the datastore automatically reverts to the original name. You can change the name only through VirtualCenter.
To view a list of available datastores

1. Click a datacenter in any of the Inventory views of a VI Client connected to a VirtualCenter Server.

![Figure 4-7 Inventory: Datastores](image)

To view the datastores panel

1. Click Inventory: Datastores in the navigation bar of a VI Client connected to a VirtualCenter Server.

To view information about a specific datastore

1. With the Datastores panel displayed, click the appropriate datastore in the inventory panel.
The corresponding Summary, Virtual Machines, and Hosts tabs appear.

For more information on datastores, refer to Server Configuration Guide.

To browse for a file on a datastore using the datastore browser

1. From the Datastores inventory panel, select a datastore.
   You might browse a datastore to find a template that needs to be registered on
   the host using the Inventory wizard.

2. Right-click and choose Browse Datastore.
   The datastore browser appears.

   A separate window displays the file system on the datastore.

3. Enter the search criteria on the Search tab or search the datastore’s hierarchy in
   the Folders tab.
Templates

A template is a golden image of a virtual machine. This image typically includes a specified operating system and configuration, which provides virtual counterparts to hardware components, and a set of applications. Using templates allows you to capture a master copy of a virtual machine from which you can make copies without having to create and configure each one separately.

Virtual machines and templates are included within a single domain and can be managed together. You can order collections of virtual machines and templates into arbitrary folders and apply a variety of permissions to both virtual machines and templates. Virtual machines can be transformed into templates without requiring a full copy of the virtual machine files and the creation of a new object.

You can use templates to create new virtual machines by cloning the template as a virtual machine. When complete, the deployed virtual machine is added to the inventory panel datacenter where the host resides.

Templates are created from existing virtual machines. After a template is created, if it is residing on a VMFS volume or a datastore, it can be deployed to only managed hosts that have direct access to that datastore. On ESX Server hosts, the datastores are the VMFS, local, or NAS volumes that you configured for your ESX Server.

To edit or update the virtual machine properties, for example, to apply a patch or install an application, you would convert the template to a virtual machine, perform the action, and then make the virtual machine a template again. If there are no changes to be made, you would simply deploy a new instance. See the VI Client Online Help for more information.
To view templates, select the a datacenter and select the Virtual Machines tab. All virtual machines and templates for the datacenter are visible here. Virtual machines and templates have different icons.

Figure 4-10 Templates and Virtual Machines for New Datacenter

If a managed host that has templates stored local to the host is removed from VirtualCenter, all the templates are also removed. Returning the managed host to VirtualCenter does not re-register the templates because they are invisible to the host, that is, not registered. When a host is added back to VirtualCenter, you can register the templates, making them visible.
VirtualCenter marks that virtual machine as a template and displays the task in the Recent Tasks pane.

![Figure 4-11: Templates Listed in Recent Task Pane](image)

**Template Registry**
Templates are currently associated with hosts, and the only supported way to regain or register templates after deleting them from a host is to use the datastore browser to locate the template. Then use the inventory wizard to name and register the .vmtx file as a template back into VirtualCenter.

Deleting an existing template unregisters the template.

**Virtual Machine Properties Editor**

The Virtual Machine Properties Editor is discussed in the online help with the exception of Audio Configuration.

**Changing the Audio Configuration**
Whether or not you have sound on your virtual machine depends on your guest operating system (guest OS). If the virtual machine is located on a ESX Server and you are using Windows XP, sound is available. However, if your guest OS is Windows 2000 or 2003, sound is not available to you.
To change the audio configuration

1. From the VirtualCenter client, click Inventory in the navigation bar.
2. Expand the inventory as needed and click the appropriate virtual machine.
3. To display the Virtual Machine Properties dialog box, in the Summary tab, click Edit Properties or choose Edit > Properties.
4. Click the Hardware tab.
5. Click Audio in the Device list.
6. Under Device status, the default setting is Connect at power on.
   Deselect the check box if you do not want the sound adapter to be connected when the virtual machine powers on.
7. Select Use default host sound adapter to use the default host sound adapter or select Specify host sound adapter and select a specific adapter from the list.
8. Click OK to save your changes.

The Virtual Machine Properties dialog box closes.

Migration with VMotion

This section describes migrating or moving a virtual machine from one host to another. Migrating a powered-off virtual machine is called migration. Migrating a powered-on virtual machine is called migration with VMotion. Migration with VMotion, designed to be used between highly compatible systems, allows you to migrate virtual machines with no downtime but requires VMotion licensing and specific configuration. In this release, you can migrate a virtual machine in a suspended state using the migration API.

Note: Copying a virtual machine is creating a new virtual machine. It is not a form of migration.

Understanding the Migration Options

In VirtualCenter 1.x, you had two options:

- Migration—Moving a powered-off virtual machine (configuration files and disk files).
- Migration with VMotion—Moving a virtual machine between hosts while the virtual machine is powered on and performing transactions (memory and configuration files only). This functionality has specific requirements, including the activation of VMotion on both the source and target host. When a migration
with VMotion is performed, the operations of the virtual machine can continue without interruption.

In VirtualCenter 2.0, you have two migration options and one relocation option:

- **Migration**
  - **Migration**—Moving a powered-off virtual machine (configuration files but no disk movement).
    
    When a virtual machine is suspended, migration moves only configuration files with no disk movement.

    **Note:** Virtual machines must be available in a SAN.

- **Migration with VMotion**—Moving a virtual machine that is powered on.

- **Relocation**
  - Migration moves configuration and disk files to their destination when a virtual machine is powered off or suspended.

  **Note:** Virtual machines do not need to be available in SAN.

For virtual machines on VMFS3 that are migrated from one ESX Server host to another, the virtual machine’s configuration file is already on the SAN and does not need to be moved by migration or migration with VMotion.

Virtual machines can be moved between hosts within the same datacenter. Virtual machines cannot be moved between datacenters.

**Note:** You cannot migrate virtual machines with raw disks. You cannot migrate with VMotion virtual machines with raw or clustered disks.

**Migration with VMotion**

VMotion allows working processes to continue throughout a migration with VMotion. The entire state of the virtual machine as well as its configuration file, if necessary, are moved to the new host even while the data storage remains in the same location on the SAN. The associated virtual disk remains in the same location on the SAN storage that is shared between the two hosts. Once the configuration file is migrated to the alternate host, the virtual machine runs on the new host.

The state information includes the current memory content and all the information that defines and identifies the virtual machine. The memory content includes transaction data and whatever bits of the operating system and applications are in the memory. The defining and identification information stored in the state includes all the data that maps to the virtual machine hardware elements, such as BIOS, devices, CPU, MAC addresses for the Ethernet cards, chip set states, registers, and so forth.
Migration with VMotion happens in three stages:
1. When the migration with VMotion is requested, VirtualCenter verifies that the existing virtual machine is in a stable state with its current host.
2. The virtual machine state information, that is, memory, registers, and network connections, is copied to the target host.
3. The virtual machine resumes its activities on the new host.

If any error occurs during migration, the virtual machines revert to their original states and locations.

You can move virtual machines manually or set up a scheduled task to perform the migration. Refer to the Virtual Infrastructure Users Guide for information on scheduling tasks.

Migration

Migration requires that the virtual machine being migrated is powered off or suspended prior to beginning the migration process. With a migration, you also have the option of moving the associated disks from one host to another. A migration consists of the following steps:

1. The configuration files, including the NVRAM file (BIOS settings), log files, and the suspend file for suspended virtual machines, and the disks of the virtual machine are moved from the source host to the destination host’s associated storage area.
2. The virtual machine is associated (registered) with the new host.
3. After the migration is completed, the old version of the virtual machine is deleted from the source host.

If any error occurs during migration, the virtual machines revert to their original states and locations.

You can move virtual machines manually or set up a scheduled task to perform the migration. Refer to the Virtual Infrastructure Users Guide for information on scheduling tasks.

Customizing Guest Operating Systems

Now that you have created and configured a virtual machine, you have the option to customize the identity and network settings of your virtual machine’s guest operating system so that it is ready to begin work immediately in your target environment.
You can save your virtual machine settings in a specification that you can recall later and reuse. You do this using the customization wizard. This specification is a text file that can be exported from the Customization Specification Manager, edited, and imported back into the manager.

There are two ways to access the customization wizard: using the customization specification manager, which lets you create specifications and store them in the database for later use, and using the wizard when you're cloning a new virtual machine. See the VI Client Online Help for more information. To install a guest operating system, see the Guest Operating System Installation Guide.

**Preparing for Guest Customization**

When you create a template or clone an existing virtual machine, you have the opportunity to customize the new guest operating system. The Guest Customization Wizard guides you through the configuration options. See the VI Client Online Help for more information.

Before you run the Guest Customization Wizard, if you intend to perform a Guest Customization, do the following:

- Verify that your system meets the guest customization requirements.
- Install the required components on the Windows machine where the VirtualCenter server is installed.

**Note:** After deploying and customizing non-volume-licensed versions of Windows XP or Windows 2003, you might need to reactivate your Microsoft operating system on the new virtual machine.

**Installing the Microsoft Sysprep Tools**

If you plan to customize a Windows guest operating system, you must first install the Microsoft Sysprep tools on your VirtualCenter server machine.

Microsoft includes the Sysprep tool set on the installation CD-ROMs for Windows 2000, Windows XP, and Windows 2003. It also distributes Sysprep 1.1 from the Microsoft Web site. In order to perform a Windows customization, you must install the Sysprep tools either from your installation CD-ROM or from the 1.1 download package.

During customization, VirtualCenter searches for the Sysprep package corresponding to your guest operating system. If the Sysprep tools are not found under the corresponding provided operating system directory, VirtualCenter searches in the provided \1.1 directory. If VirtualCenter does not find any Sysprep tools, the Windows virtual machine customization does not proceed.
**To install the Microsoft Sysprep tools from a Microsoft Web site download:**

4. Download the Sysprep package from:
   
   
   Although the Sysprep version indicates Windows 2000, it works with both Windows XP Professional and Windows Server 2003.

5. Click Next to continue.

6. Click I agree to accept the terms and conditions.

7. Click Download.

8. Save the file to your local disk.

9. Run the Microsoft installer:
   
   Q257813_w2k_sp1_x86_en.exe

10. Extract the files to the provided directory.
   
   The following Sysprep support directories were created during VirtualCenter installation:
   
   C:\<ALLUSERSPROFILE>\Application Data\VMware\VMware VirtualCenter\sysprep
   ...\sysprep\1.1\n   ...\sysprep\2k\n   ...\sysprep\xp\n   ...\sysprep\svr2003\n   
   where <ALLUSERSPROFILE> is usually \Documents And Settings\All Users\. This is where vpxd.cfg is also located.

   Select the 1.1 subdirectory.

11. Click OK to expand the files.
   
   After you have extracted the files from Q257813_w2k_sp1_x86_en.exe to the \1.1 directory, you should see:
   
   ...\sysprep\1.1\docs\n   ...\sysprep\1.1\samples\n   ...\sysprep\1.1\tools\n   ...\sysprep\1.1\contents.txt

**To install the Microsoft Sysprep tools from the Windows operating system CD**

1. Insert the Windows operating system CD into the CD-ROM, for example, D: drive.
2. Locate the DEPLOY.CAB file in the CD directory, Support\Tools.

3. Open and expand the DEPLOY.CAB file, using a tool such as Winzip.exe or another tool capable of reading Microsoft CAB files.

4. Extract the files to the provided directory appropriate to your Sysprep guest operating system.
   The following Sysprep support directories were created during VirtualCenter installation:
   C:\<ALLUSERSPROFILE>\Application Data\VMware\VMware VirtualCenter\sysprep
   ...\sysprep\1.1\n   ...\sysprep\2k\n   ...\sysprep\xp\n   ...\sysprep\svr2003\n   where <ALLUSERSPROFILE> is usually Documents And Settings\All Users\. This is where vpxd.cfg is also located.
   Select the subdirectory that corresponds to your operating system.

5. Click OK to expand the files.
   After you have extracted the files from DEPLOY.CAB, you should see:
   ...\sysprep\<guest>\deptool.chm
   ...\sysprep\<guest>\readme.txt
   ...\sysprep\<guest>\setupcl.exe
   ...\sysprep\<guest>\setupmgr.exe
   ...\sysprep\<guest>\setupmgx.dll
   ...\sysprep\<guest>\sysprep.exe
   ...\sysprep\<guest>\unattend.doc
   where <guest> is either 2k, xp, or svr2003.

6. Repeat this procedure to extract Sysprep files for each of the Windows guest operating system (Windows 2000, Windows XP, or Windows 2003) you plan to customize using Virtual Center.

You are now ready to customize a new virtual machine with a supported Windows guest operating system when you clone an existing virtual machine.
This chapter gives an overview of VI Client.

- Monitoring on page 86
- Performance Charts on page 88
- Maps on page 92
- SNMP on page 93
Monitoring

After you’ve added hosts to VirtualCenter and created and powered-on virtual machines, you need to customize and monitor your environment. This section looks at some available options.

To monitor your Virtual Infrastructure

1. Select the Datacenter.

2. Notice that you can choose to display either tasks or events for the datacenter, by clicking either the Tasks or the Events button below the line of tabs. You can then select individual tasks or events to see additional information in the Details pane at the bottom of the window.

3. To view just events, click Events in the navigation bar.
4. Selecting Events displays alarms or informational messages. You can export them to a file by clicking **Export Events**. See the *VI Client Online Help* for more information.

When you are ready to expand or restructure your Virtual Infrastructure environment, you might find it useful to view a map of hosts and virtual machines, hosts and storage devices, or other information.

5. Select the item for which you wish to have more information and click the **Maps** tab. The VI Client displays a map, which you can customize as needed.
Performance Charts

The Performance tab is available when you select a cluster, resource pool, host, or virtual machine from the inventory panel. The Performance tab displays the selected object’s resource performance in graph and list form. Performance views show graphs for resources specific to the selected inventory object.

ESX Servers connected to a VI Client directly have limited statistical information that is displayed in the Performance tabs. To get the full chart functionality, have the VirtualCenter Server manage the ESX Server.

Statistics Level

Virtual Center does not collect all supported performance statistics by default. The performance counters collected are controlled by the Statistics Level. Currently, there are four levels as shown in Table 5-1.

Table 5-1 Statistics Levels

<table>
<thead>
<tr>
<th>Statistics Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>This level includes the basic metrics: Average Usage for CPU, Memory, Disk, and Network; System Uptime, System Heartbeat, and DRS metrics. Statistics for devices are not included at this level.</td>
</tr>
</tbody>
</table>
Configuring the Statistics Level

The Statistics Level is a numeric value that can be configured using either VI Client or vpxd.cfg (key 'vpxd.stats.filterLevel').

To set the statistics level using VI Client

1. Selecting Administration > Virtual Infrastructure Client Settings.
   The VirtualCenter Configuration Wizard appears.
2. Select the Statistics link.
3. In the System Resources section, select the Statistics Level.

The value in the configuration file overrides the value in the VI Client at startup. Subsequent changes to the level override it.

Note: You must restart the VI Client if you make changes using vpxd.cfg.

The default value is 1. Do not set a higher statistics level than you need. Increasing the level increases the amount of regular statistics processing done by VirtualCenter and can cause additional performance overhead.

Performance Chart Measurements

Table 5-2 lists the measurement options for each resource monitored on a host. The abbreviations used are VC-VirtualCenter Server, H-Host/ESX Server.

Table 5-2 Measurement Options

<table>
<thead>
<tr>
<th>Inventory Object</th>
<th>Resource</th>
<th>Item Measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>R Pool</td>
<td>VM Host Name</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>VC H</td>
<td>VC H</td>
</tr>
</tbody>
</table>
### Inventory Object

<table>
<thead>
<tr>
<th>Cluster</th>
<th>R Pool</th>
<th>VM</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>VC</td>
<td>VC</td>
</tr>
</tbody>
</table>

### Resource

<table>
<thead>
<tr>
<th>Host</th>
<th>Name</th>
<th>Item Measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>VC</td>
<td>CPU reserved capacity</td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>CPU time spent on wait state</td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>CPU time spent on ready state</td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>CPU time spent on system processes</td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>CPU time that is extra</td>
<td></td>
</tr>
<tr>
<td>VC</td>
<td>CPU time that is guaranteed</td>
<td></td>
</tr>
</tbody>
</table>

### Memory Performance Chart

| VC   | VC H | Memory usage as percentage of total available memory |
| VC   | VC H | Memory zero |
| VC   | VC H | Memory state |
| VC   | VC H | Free space in memory heap |
| VC   | VC H | Memory reserved capacity |
| VC   | VC H | Amount of memory granted |
| VC   | VC H | Amount of memory used by memory control |
| VC   | VC H | Amount of memory that can be used by memory control |
| VC   | VC H | Amount of memory that is unreserved |
| VC   | VC H | Amount of memory that is unreserved by swap |
| VC   | VC H | Amount of memory that is actively used |
| VC   | VC H | Amount of memory that is shared |
| VC   | VC H | Amount of memory that is used by swap |
| VC   | VC H | Amount of memory that can be swapped |
| VC   | VC H | Amount of memory that is swapped |
| VC   | VC H | Amount of memory that is swapped in |
| VC   | VC H | Amount of memory that is swapped out |
| VC   | VC H | Amount of memory that is an overhead |
| VC   | VC H | Amount of memory that is allocated for heap |
| VC   | VC H | Amount of memory that is shared by common |

### DRS

<p>| VC   | DRS effective CPU resources available |
| VC   | DRS effective Memory resources available |</p>
<table>
<thead>
<tr>
<th>Inventory Object</th>
<th>Resource</th>
<th>Item Measured</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cluster</td>
<td>R Pool</td>
<td>VM Host</td>
</tr>
<tr>
<td>VC</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Performance Chart</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Amount of data read from the disk in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Amount of data written to the disk in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Aggregated storage performance statistics</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Number of disk writes in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Number of disk reads in the period</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Network Performance Chart</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Aggregated network performance statistics</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Amount of data received in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Amount of data transmitted in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Number of packets transmitted in the period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Number of packets received in the period</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>System Performance Chart</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Number of seconds since startup</td>
</tr>
<tr>
<td>VC H</td>
<td></td>
<td>Number of heartbeats in this period</td>
</tr>
<tr>
<td>VC H</td>
<td></td>
<td>Resource CPU usage</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resource Group CPU Performance Chart</td>
<td></td>
<td></td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU sample period</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU sample count</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU scheduling limit over one minute</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU scheduling limit over 5 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU scheduling limit over 15 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running peak over 1 minute</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running peak over 5 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running peak over 15 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running average over 1 minute</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running average over 5 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU running average over 15 minutes</td>
</tr>
<tr>
<td>VC H</td>
<td>VC H</td>
<td>Resource Group CPU active peak over 1 minute</td>
</tr>
</tbody>
</table>
Maps

The Maps feature of VI Client provides a visual understanding of the relationships between the virtual and physical resources available in their VirtualCenter. Maps of the items within VirtualCenter are available through the Maps tabs for hosts, virtual machines, networks, or datastores in the inventory (Inventory Maps) and through the Maps button in the navigation bar (Global Maps). There are three map types:

- **Global Maps** — Accessible from the button in the large toolbar. The Global Map provides a high-level view of the relationships between all physical and virtual elements in the entire VirtualCenter environment. By selecting or deselecting the boxes on the side of the inventory, you can see which clusters or hosts are most densely populated, which networks are most critical, and which storage devices are being utilized.

- **Inventory Maps** — Accessible from the inventory view. The Inventory Map shows a selected item’s relevant host, virtual machine, network, and storage relationships. This makes it easy to understand which items are affected or attached to the item in question. These maps appear for folders, datacenters, clusters, resource pools, and hosts.

The Maps tab is available when you select a folders, datacenters, clusters, resource pools, hosts, or virtual machines from the inventory panel of the navigation bar.
• **VMotion Resource Maps** — Appears only in the tabs for virtual machines selected in the inventory. In addition to visual representations of the resources (hosts, datastores, and networks) associated with a virtual machine, the VMotion Resource Maps display which hosts in a virtual machine’s cluster or datacenter are candidate hosts to which a virtual machine can migrate. The VMotion map provides information about which hosts are heavily loaded, which are connected to all the same resources that the target virtual machine is connected to, and which hosts have compatible CPU and software with the target virtual machine.

**SNMP**

The SNMP agent controls a database called the SNMP Management Information Base (MIB), a standard set of statistical and control values.

**Using MIBs with Your SNMP Traps**

VirtualCenter allows you to configure SNMP version 1 traps for alarm notification of events occurring in VirtualCenter; however, continue to use your ESX Server MIBs for host-related alarms.

The traps defined here are sent typically to other management programs. These management programs need to know how to interpret the SNMP traps sent by VirtualCenter.

To configure your management program to interpret VirtualCenter SNMP traps

1. Download the management information base (MIB) definitions.
   - VMWARE-ROOT-MIB.mib
   - VMWARE-TRAPS-MIB.mib
   
   The MIB definition files can be found at C:\Program Files\VMware\VMware VirtualCenter\MIBS when the default installation directory is used.

2. Modify your management program to include and interpret the VMware MIBs.

   Refer to your management program documentation for information on adding MIB definitions to your program.


**SNMP Trap and Variable Definitions**

You can download two groups of SNMP MIB definitions.
The SNMP trap tree for VI Client is at:

```
(.1.3.6.1.4.1.6876.50.).
```

The SNMP trap type for VMware VirtualCenter is 201.

Table 5-3 lists the identification mapping for each VirtualCenter MIB group.

### Table 5-3 Identification Mapping

<table>
<thead>
<tr>
<th>Identification Map</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.3.6.1.4.1.6876.50.301</td>
<td>vpxdTrap Type</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.302</td>
<td>vpxdHostName</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.303</td>
<td>vpxdVMName</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.304</td>
<td>vpxdOldStatus</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.305</td>
<td>vpxdNewStatus</td>
</tr>
<tr>
<td>1.3.6.1.4.1.6876.50.306</td>
<td>vpxObjValue</td>
</tr>
</tbody>
</table>

The following tables describe the VMware SNMP MIB root and primary sub-trees. Currently each sub-tree has its own MIB file. The tables list the variables used in the SNMP Trap groups.

Table 5-4 lists the definition mapping from VMWARE-ROOT-MIB.mib.

### Table 5-4 Definition Mapping

<table>
<thead>
<tr>
<th>Label</th>
<th>Identification Mapping</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmware</td>
<td>enterprises 6876</td>
</tr>
<tr>
<td>vmwSystem</td>
<td>vmware 1</td>
</tr>
<tr>
<td>vmwVirtMachines</td>
<td>vmware 2</td>
</tr>
<tr>
<td>vmwResources</td>
<td>vmware 3</td>
</tr>
<tr>
<td>vmwProductSpecific</td>
<td>vmware 4</td>
</tr>
<tr>
<td>vmwTraps</td>
<td>vmware 50</td>
</tr>
<tr>
<td>vmwOID</td>
<td>vmware 60</td>
</tr>
<tr>
<td>vmwExperimental</td>
<td>vmware 700</td>
</tr>
</tbody>
</table>

Table 5-5 lists the trap types from VMWARE-TRAPS-MIB.mib. The first five traps are generated from the ESX Server, and the last one from the VirtualCenter Server.
**Table 5-5 Trap Types**

<table>
<thead>
<tr>
<th>Trap Label</th>
<th>Description</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmPoweredOn</td>
<td>Sent when a virtual machine is powered on from a suspended or a powered off state.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmPoweredOff</td>
<td>Sent when a virtual machine is powered off.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmHBLost</td>
<td>Sent when a virtual machine detects a loss in guest heartbeat.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmHBDetected</td>
<td>Sent when a virtual machine detects or regains the guest heartbeat.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vmSuspended</td>
<td>Sent when a virtual machine is suspended.</td>
<td>vmID, vmConfigFile</td>
</tr>
<tr>
<td>vpxdTrap</td>
<td>Sent when entity status changed.</td>
<td>vpxdTrapType, vpxdHostName, vpxdVMName, vpxdOldStatus, vpxdNewStatus, vpxdObjValue</td>
</tr>
</tbody>
</table>

**Table 5-6 Variables and Parameters**

<table>
<thead>
<tr>
<th>Variable</th>
<th>Description</th>
<th>Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>vmID</td>
<td>The ID of the affected virtual machine generating the trap. If the virtual machine ID is non-existent, such as for a power-off trap -1 is returned.</td>
<td>INTEGER</td>
</tr>
<tr>
<td>vmConfigFile</td>
<td>The configuration file of the affected virtual machine generating the trap.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdTrapType</td>
<td>The trap type in the preceding traps.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdHostName</td>
<td>The name of the host in the preceding traps.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdVMName</td>
<td>The name of the virtual machine in the preceding traps.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdOldStatus</td>
<td>The old status in the preceding traps.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdNewStatus</td>
<td>The new status in the preceding traps.</td>
<td>DisplayString</td>
</tr>
<tr>
<td>vpxdObjValue</td>
<td>The current object value in the preceding traps.</td>
<td>DisplayString</td>
</tr>
</tbody>
</table>
Using SNMP to Monitor the Computer Running ESX Server

ESX Server ships with an SNMP agent that allows you to monitor the health of the physical machine where ESX Server is running and of virtual machines running on it. This agent is based on Net-SNMP with enhancements to support data specific to ESX Server. Background information on Net-SNMP is available at net-snmp.sourceforge.net.

The ESX Server SNMP agent can be used with any management software that can load and compile a management information base (MIB) in SMIv1 format and can understand SNMPv1 trap messages.

The location of the VMware sub-tree in the SNMP hierarchy is:

.iso.org.dod.internet.private.enterprises.vmware (.1.3.6.1.4.1.6876).

You can choose to use SNMP with or without any ESX Server MIB items.

Information about the Physical Computer

SNMP get variables allow you to monitor a wide variety of items about the physical computer and how virtual machines are using its resources. Some of the key types of information available are:

- Number of CPUs on the physical computer
- CPU resources on the physical computer being used by particular virtual machines
- Amount of RAM installed on the physical computer
- Physical memory used by the service console
- Physical memory used by particular virtual machines
- Physical memory that is not being used
- Usage data for disks on the physical computer, including number of reads and writes and amount of data read and written
- Usage data on the physical computer’s network adapters, including packets sent and received and kilobytes sent and received
- State of the VMkernel (loaded or not loaded)

**Note:** If the variable showing whether the VMkernel is loaded says no, any values reported for any other variable should be regarded as invalid.
Information about the Virtual Machines
SNMP get: variables allow you to monitor a number of items about particular virtual machines running on the computer. Some of the key types of information available are:

- Path to the virtual machine's configuration file
- Guest operating system running on the virtual machine
- Amount of memory the virtual machine is configured to use
- State of the virtual machine's power switch: on or off
- State of the guest operating system: on or off (running or not running)
- Disk adapters seen by the virtual machine
- Network adapters seen by the virtual machine
- Floppy disk drives seen by the virtual machine
- State of the floppy drive: connected or disconnected
- CD-ROM drives seen by the virtual machine
- State of the CD-ROM drive: connected or disconnected

SNMP Traps
Five SNMP traps notify you of critical events in particular virtual machines. The affected virtual machine is identified by ID number and configuration file path. The traps notify you:

- When a virtual machine is powered on or resumed from a suspended state.
- When a virtual machine is powered off.
- When the virtual machine detects a loss of heartbeat in the guest operating system.
- When a virtual machine is suspended.
- When the virtual machine detects that the guest operating system's heartbeat has started or resumed.

Note: VMware Tools must be installed in the guest operating system to support the traps that detect loss and resumption of the guest’s heartbeat.

Setting Up ESX Server SNMP
ESX Server SNMP support is a module you can load into a daemon based on the net-snmp package. It is compiled for version 5.0.9.2.30E.19 of that package. That version of net-snmp is installed in the Service Console by default.
Installing the ESX Server SNMP Module
The VMware-specific SNMP modules are automatically installed when you install ESX Server. By default on a fresh install, ESX Server components are enabled in SNMP, and VMware traps are always on.

Installing the ESX Server MIB Module
You must make manual changes after upgrading ESX server because the MIB module is not be present in upgrades, only fresh installs. You might also have to make changes after installing third-party management agents because the state of the configuration is unknown.

Configuring the ESX Server Agent from the Service Console
The following procedures must be performed after installing or upgrading third-party management applications.

To enable or disable ESX Server MIB
1. Log into the service console as the root user.
2. Edit the `/etc/snmp/snmpd.conf` configuration file.
3. Add or remove the following line to enable or disable VMware MIB items:
   ```
   dlmmod SNMPESX /usr/lib/vmware/snmp/libSNMPESX.so
   ```

To start the SNMP agents automatically
You can set the SNMP daemon to start automatically whenever ESX Server boots by logging in as the root user in the service console and running the `chkconfig` command:
```
chkconfig snmpd on
```

To start the SNMP agents manually
If you need to start the SNMP agent manually, log in as root in the service console and run the following command:
```
/etc/rc.d/init.d/snmpd start
```
By default, the agent starts and runs as background processes.

To enable and disable traps
1. Edit the `config.xml` file.
   The configuration parameter `snmp/generateTraps` in the `/etc/vmware/host/config.xml` file determines whether or not to generate a trap. By default, a trap is generated.
2. Restart `vmware_hostd` for the change to take effect.
CHAPTER 5 Performing Administrative Tasks

Configuring SNMP Trap Destinations
VMware traps are generated to the destinations specified in the configuration file.

To configure traps
1. Log into the service console as the root user.
2. Modify the /etc/snmp/snmpd.conf file.
3. Using a text editor, add the following line, replacing mercury.solar.com with the name of the host on your network that will receive traps.
   trapsink mercury.solar.com
   Repeat this line to specify more than one destination.
4. Add the following line, replacing public with a community name of your choice.
   trapcommunity public
   Only one instance of this line is allowed:
5. Save your changes.

Configuring SNMP Management Client Software
To use your SNMP management software with the ESX Server agent, take the steps needed to accomplish the following:

- In your management software, specify the ESX Server machine as an SNMP-based managed device.
- Set up appropriate community names in the management software. These must correspond to the values set in the master SNMP agent's configuration file, for example, rocommunity, trapcommunity, and trapsink.
- Load the ESX Server MIBs into the management software so you can view the symbolic names for the ESX Server variables. You can find the MIB files on ESX Server, in the /usr/lib/vmware/snmp/mibs directory.

Configuring SNMP Security
The ESX Server SNMP package takes the simplest approach to SNMP security in the default configuration. It sets up a single community with read-only access. This is denoted by the rocommunity configuration parameter in the configuration file for the snmpd daemon, snmpd.conf. You should change this file.

Other enhancements to the SNMP security mechanism allow an administrator to set up a more elaborate permissions scheme. See the snmpd.conf(5) man page for details.
Using SNMP with Guest Operating Systems

To use SNMP to monitor guest operating systems or applications running in virtual machines, install the SNMP agents you normally would use for that purpose in the guest operating systems. No special configuration is required on ESX Server. The virtual machine uses its own virtual hardware devices. You should not install agents intended to monitor hardware on the physical computer in the virtual machine.
This chapter contains best practices for several different parts of the Virtual Infrastructure. The following sections are included:

- Setup and General Issues on page 102
- Sizing for Optimal Resource Consumption on page 102
- Virtual SMP Best Practices on page 103
- Storage Best Practices on page 104
- Related Publications on page 105
Setup and General Issues

1. It is important to validate hardware:
   - Test memory for 72 hours.
   - Check performance of hardware components using a Windows or Linux operating system to make sure they are running at their maximum capacities. Run benchmarks if necessary.
   - Check installed items against the supported hardware list.
   - Use minimum configuration or greater.

2. Plan the deployment. Allocate enough resources especially for the Service Console. The following table lists symptoms of insufficient resources for the service console:

<table>
<thead>
<tr>
<th>Resource Type</th>
<th>Symptoms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service console RAM</td>
<td>Poor VI Client response</td>
</tr>
<tr>
<td>Service console Swap</td>
<td>Inability to start new virtual machines</td>
</tr>
<tr>
<td>Service console Disk</td>
<td>Inability to write diagnostic messages to log, inability to log into the service console</td>
</tr>
</tbody>
</table>

3. Use only supported guests. See the Guest Operating System Installation Guide.

4. Install tools:
   a. Make sure you're using VMware supplied Bus Logic driver.

5. Always use VMware Tools to measure resource utilization. Use VI Client or esxtop as CPU usage and memory usage reported in the guest can be different from what ESX reports.

Sizing for Optimal Resource Consumption

1. Disable screen savers and Window animations in the virtual machine. On Linux, if using an X server is not required, disable it. Screen savers, animations, and X servers all consume extra CPU which can affect performance of other virtual machines and consolidation ratios.

2. If possible, use less than 768MB of guest physical memory on Linux virtual machines. Linux uses different techniques to map memory in the kernel if the amount of physical memory is greater than 768MB. These techniques impose
additional overhead on the virtual machine monitor and can result in degraded performance.

3. Disconnect unused, unnecessary devices:
   - COM ports
   - LPT ports
   - Floppy drives
   - CD-ROM drives
   - USB adapters

Disabling these devices frees IRQ resources and eliminates IRQ sharing conflicts within the guest operating system that can cause performance problems. Some devices, such as USB, also consume extra CPU because they operate on a polling scheme.

4. Service console programs. Avoid running programs in the service console that consume excessive amounts of CPU or memory. This can adversely affect performance of the virtual machines and VirtualCenter. It’s a good idea to periodically monitor service console memory and CPU usage using esxtop.

5. If ESX is overcommitted on memory, virtual machine performance is greatly affected (make sure ESX is not swapping). Due to page sharing and other techniques, ESX server can be overcommitted on memory but not swap. However, if the over-commitment is large and ESX is swapping, performance in the virtual machines is significantly reduced.

6. Schedule backups and anti-virus programs in the virtual machines to run at off-peak hours. In general, it’s a good idea to distribute CPU consumption evenly not just across CPUs but also across time. For workloads, such as backups and antivirus where the load is predictable, this is easily achieved by scheduling the jobs appropriately.

**Virtual SMP Best Practices**

1. Use as few virtual CPUs (VCPU) as possible. Don’t run single threaded applications in an SMP virtual machine, for example. Having virtual machines configured with virtual CPUs that are not used still imposes resource requirements on the ESX Servers. The unused virtual CPU still consumes timer interrupts and executes the idle loop of the guest operating system which translates to real CPU consumption from the point of view of the ESX Server. Also, in ESX we try to co-schedule the multiple VCPUs of an SMP virtual machine;
that is, we try to run them together in parallel as much as possible. Having unused VCPUs imposes scheduling constraint on the VCPU that is actually being used and might degrade its performance.

2. If you are running multi-threaded or multi-process applications in an SMP guest, sometimes it may help to pin guest threads or processes to VCPUs. When processes in the guest migrate from one VCPU to another, they incur small virtual overheads. If the migration is very frequent, it may help to pin the process in the guest to a particular VCPU.

   Note: Performance for this scenario has been improved in ESX Server 3.

3. Monitor idle loop spin parameter. Certain guest operating systems do not actually halt the virtual CPU when they idle. Since the virtual CPU is not halted, ESX will continue to run and schedule this virtual CPU as if it were still doing useful work. To prevent such unneeded CPU consumption, ESX detects that a guest VCPU is attempting to idle and deschedules it. The detection heuristic is controlled by the idle loop spin parameter and can sometimes affect performance. See Related Publications on page 105.

**Storage Best Practices**

1. Backend storage configuration greatly affects performance:
   - See ESX SAN best practices
   - See NFS SAN best practices
   - See iSCSI SAN best practices

   Lots of workloads are very sensitive to the latency of I/O operations; therefore, it's very important to have the storage device configured correctly. This is a vast area that depends on workload, hardware, vendor, RAID levels, cache sizes, stripe sizes, and so on. Consult the appropriate documentation from VMware as well as the storage vendor.

2. Make sure I/O is not queueing up in the vmkernel by checking the number of queued commands reported by esxtop. If queueing, then try to adjust queue depths. See Related Publications on page 105.
# Related Publications

<table>
<thead>
<tr>
<th>Issue</th>
<th>Publication</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mismatched HALs</td>
<td>KB article 1077</td>
</tr>
<tr>
<td>Idle loop</td>
<td>KB article 1730</td>
</tr>
<tr>
<td>CPU utilization</td>
<td>KB article 2032</td>
</tr>
<tr>
<td>Queue depths on QLogic</td>
<td>KB article 1267</td>
</tr>
<tr>
<td>Disk outstanding commands parameter</td>
<td>KB article 1268</td>
</tr>
<tr>
<td>Memory allocation</td>
<td>Resource Management Guide</td>
</tr>
<tr>
<td>Swap space</td>
<td>Resource Management Guide</td>
</tr>
</tbody>
</table>